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GNU Image Manipulation Program (Program GNU do manipulacji obrazem), lub inaczej 

Gimp, jest potê¿nym i z³o¿onym programem open source s³u¿¹cym do edycji obrazu. 

Poniewa¿ mo¿liwo�ci Gimpa mog¹ byæ rozszerzane za pomoc¹ modu³ów i skryptów, 

jego funkcjonalno�æ jest praktycznie nieograniczona. Niniejszy leksykon opisuje Gimpa 

w wersji 1.2 oraz wszystkie modu³y rozszerzaj¹ce i skrypty bêd¹ce czê�ci¹ jego 

standardowej dystrybucji. Ta ksi¹¿ka pomo¿e zarówno nowicjuszowi, pragn¹cemu 

poznaæ mo¿liwo�ci Gimpa, jak i do�wiadczonemu u¿ytkownikowi, który poszukuje opisu 

konkretnych funkcji programu. Du¿ym nak³adem pracy udokumentowano wiele, czêsto 

ukrytych, w³asno�ci Gimpa, które sprawiaj¹, ¿e praca z nim staje siê bardziej wydajna.

Niniejszy leksykon rozpoczyna siê od opisu przybornika (Toolbox), g³ównego okna 

Gimpa oraz funkcji dostêpnych za jego pomoc¹. Druga czê�æ ksi¹¿ki zawiera opis okna 

obrazu (Image) oraz funkcji dostêpnych poprzez menu kontekstowe otwierane 

klikniêciem prawym przyciskiem myszy w dowolnym miejscu okna obrazu. Dok³adnie 

opisana zostanie hierarchia menu kontekstowego, co umo¿liwi szybsze odnalezienie 

konkretnych funkcji.

Niniejsza ksi¹¿ka opisuje równie¿ stosowanie w Gimpie niektórych mniej popularnych 

modu³ów Perla. Je¿eli modu³y te nie s¹ zainstalowane w danym systemie, nie bêdzie 

mo¿liwe skorzystanie z niektórych funkcji, które Perl do³¹cza do Gimpa. Funkcje 

wymagaj¹ce wykorzystania Perla zosta³y oznaczone ikon¹ wielb³¹da.

Zrozumienie Gimpa oraz, ogólnie mówi¹c, manipulacji obrazem wymaga rozumienia 

niektórych terminów technicznych. Terminy te zosta³y wyja�nione na koñcu ksi¹¿ki, 

razem z list¹ formatów plików obrazów obs³ugiwanych przez Gimpa oraz 

odpowiadaj¹cych im w³a�ciwo�ci.
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GIMP
Wyświetla obszar, w którym można zmieniać cztery kanału
koloru. Po prawej stronie można zmieniać kanał trzeci. Jedno
z pól wyboru po prawej stronie kontroluje trzeci kanał. Wybrać
można dowolny kolor z przestrzeni RGB lub HSV (zob. „Mo-
dele koloru”).

Watercolor (Akwarela)
Imituje mieszanie akwareli. Można pobrać nieco koloru z lewego
pola poprzez kliknięcie lewym przyciskiem myszy; przycisk
prawy uwolni wybrany kolor.

Triangle (Trójkąt)
Umożliwia wybranie koloru bliskiego subiektywnej percepcji
koloru. Należy obracać trójkąt by zmienić barwy. Nasycenie i ja-
sność można wybrać z samego trójkąta.

GTK
Wyświetla standardowe okno dialogowe wyboru koloru GTK
— używane także przez moduły rozszerzające i skrypty. Barwa
i nasycenie są konfigurowane w oknie po lewej stronie, a jasność
w polu po prawej.
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Te obszary wyświetlają aktualnie aktywny pędzel, wzór i gradient. Przy
kliknięciu na jedno z tych pól wywołane zostaje odpowiednie okno dia-
logowe (zob. „Okna dialogowe”). Dodatkowo, obszary te są wykorzy-
stywane jako źródła i miejsca docelowe dla operacji przeciągnij-i-upuść.
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Każdemu otwartemu rysunkowi przypisane jest przynajmniej jedno okno
obrazu. W celu oszczędzenia miejsca na ekranie okna te posiadają jedy-
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nie niezbędne elementy. W lewym górnym rogu okien znajduje się ikona
trójkąta, umożliwiająca otwarcie menu kontekstowego (<Image> (<Ob-
razek>)). Menu to jest również dostępne w każdej chwili pod prawym
przyciskiem myszy. Poszczególne elementy okna obrazu opisaliśmy na
rysunku 2. Opcje menu <Image> (<Obrazek>) opisano poniżej.

Rysunek 2. Okno obrazu Gimpa i jego elementy

Wzdłuż lewej i górnej krawędzi rysunku znajdują się linijki, na których
przedstawiana jest aktualna pozycja wskaźnika myszy. Informacje
o dokładnej pozycji wskaźnika można również znaleźć na pasku stanu.
Jeśli aktywna jest opcja Dot for Dot (Punkt dla punktu), jednostką wy-
świetlanych informacji są piksele; w przeciwnym wypadku, koordy-
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naty wyświetlane są w jednostkach rzeczywistych (na przykład calach
bądź milimetrach). Za pomocą linijek można również ustalić linie
przewodnie. Więcej informacji o tworzeniu, umiejscawianiu i usuwa-
niu linii przewodnich można znaleźć w punkcie „Move Tool (Przesu-
nięcie) (M)” działu „Narzędzia wyboru”.

Zależnie od aktualnie wybranego narzędzia, na pasku stanu obok koor-
dynatów wskaźnika myszy mogą pojawić się również dodatkowe in-
formacje. W czasie wykonywania zadań trwających dłużej niż kilka
sekund, w prawej części pasku stanu pojawia się pasek postępu. Wy-
konywane zadanie można wtedy przerwać za pomocą umieszczonego
tuż obok przycisku Cancel (Anuluj).

Dwa przyciski przy lewej dolnej krawędzi okna, tuż obok paska postę-
pu, zapewniają szybki dostęp do techniki zaznaczania znanej jako Qu-
ickMask (Szybkie maskowanie). Po naciśnięciu przycisku z czerwonym
prostokątem, na rysunek nakładana jest czerwona maska. Części ry-
sunku, które powinny zostać zaznaczone, mogą zostać wycięte z maski
lub oznaczone za pomocą jasnego koloru. Kliknięcie lewego przycisku
zaznacza elementy rysunku, poprzez analizę jasności maski. Dwukrot-
nie klikając któryś z omawianych przycisków, można otworzyć okno
dialogowe umożliwiające zmianę koloru i przeźroczystości maski. Jak
widać dzięki oknu dialogowemu Layers, Channels&Paths (Warstwy,
Kanały i Ścieżki), technika ta działa wykorzystując kanały (patrz punkt
„Channels (Kanały)” działu „Dialogs (Okna dialogowe)”); przyciski
jedynie zapewniają szybszy i wygodniejszy dostęp do niej.

Podczas pracy z dużymi rysunkami lub też przy dużych zbliżeniach,
w oknie obrazu może nie mieścić się cały rysunek. W takiej sytuacji
można przesuwać obszar widoczny przeciągając rysunek środkowym
klawiszem myszy1. Jeśli się zgubisz, kliknij ikonę krzyżyka w prawym
dolnym rogu okna obrazu (tuż poniżej prawego paska przewijania). Po
kliknięciu pojawi się okno dialogowe z miniaturą całego rysunku i ob-
ramowanym na biało obszarem, który jest aktualnie wyświetlany
w głównym oknie. Można również szybko zmienić wyświetlany frag-
___________________________

1 Jeśli mysz posiada tylko dwa przyciski, należy tak skonfigurować X serwer,

by interpretował jednoczesne przyciśnięcie obu przycisków jako przyciśnięcie

środkowego.
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ment rysunku, klikając i przeciągając obszar widoczny, w oknie dialo-
gowym.

Podczas pracy z Gimpem można mieć otwartych wiele okien i okienek
dialogowych. Aby przenieść na pierwszy plan okno obrazu, ukrywając
chwilowo wszystkie pozostałe, należy raz nacisnąć klawisz TAB. Po-
nowne naciśnięcie klawisza TAB powoduje wyświetlenie przybornika;
przyciśnięcie TAB jeszcze raz, przywołuje wszystkie pozostałe okna.

W kolejnych punktach zostały omówione wszystkie funkcje menu
<Image> (<Obrazek>) (jak wspomniano wcześniej, menu <Image>
(<Obrazek>) można wywołać poprzez kliknięcie prawym przyciskiem
myszy w obrębie okna obrazu lub klikając przycisk menu <Image>
(<Obrazek>) w lewym górnym rogu okna). Nie wszystkie funkcje dzia-
łają dla wszystkich typów rysunków. Jeżeli dana funkcja nie może zostać
wykorzystana, odpowiadająca jej pozycja menu jest nieaktywna (ozna-
czona szarym kolorem). Większość funkcji działa w trybie RGB (patrz
„Modele kolorów”), co sprawia, że wybranie go w większości przypad-
ków jest najlepszym posunięciem. Czasem niezbędne jest również doda-
nie kanału Alfa (za pomocą menu <Image>ImageAlpha→Add Alpha
Channel (<Obrazek>ImageAlpha→Dodaj kanał Alfa)).

�����������
Każde okno obrazu posiada własne menu File (Plik). Opcje opisane
poniżej dotyczą rysunku, z którego okna wywołano dane polecenie:

New (Nowy) (CTRL+N)
Tworzy nowy rysunek. Typ i rozmiar rysunku będą takie same
jak rysunku, z którego okna wywołano tę opcję.

Open (Otwórz) (CTRL+O)
Umożliwia otwarcie rysunku zapisanego na dysku. Właściwości
okna dialogowego Open (Otwórz) szczegółowo omówiono przy
opisie menu File (Plik) w części „Toolbox (Przybornik)”.
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Save (Zapisz) (CTRL+S)
Umożliwia zapisanie rysunku na dysku. Gimp rozpoznaje format
graficzny rysunków dzięki rozszerzeniom plików. Typ pliku
można wybrać na własną rękę za pomocą menu Determine File
Type (Określ typ pliku). Niektórych rysunków nie można zapisać
we wszystkich formatach graficznych. Dotyczy to szczególnie
rysunków z warstwami, ponieważ bardzo niewiele formatów gra-
ficznych pozwala na zapisanie i odzyskanie informacji o war-
stwach. W takich sytuacjach Gimp informuje użytkownika o po-
tencjalnym problemie i proponuje dokonanie konwersji rysunku
do formatu obsługiwanego przez docelowy typ pliku. Ponieważ
wszystkie zmiany są przeprowadzane na kopii, oryginalny plik
pozostanie nienaruszony2.

Dostępne typy plików wraz z ich właściwościami opisano w czę-
ści „Formaty plików”. Jednak tylko własny format Gimpa, .xcf,
pozwala na zachowanie wszystkich właściwości rysunków, ta-
kich jak warstwy, kanały, linie przewodnie i tym podobne.

Gimp może również automatycznie kompresować zapisywane
rysunki, dodając przy tym do nazw plików rozszerzenie .gz oraz
.bz2, o ile zainstalowano w systemie programy gzip lub bzip2.
Jest to rozwiązanie zalecane w przypadku korzystania z formatu
XCF, ponieważ format ten nie posiada własnych mechanizmów
kompresji. W niektórych sytuacjach użyteczny może być format
XJT. Format ten, podobnie jak XCF, przechowuje wszystkie in-
formacje o warstwach i liniach przewodnich oraz dodatkowo
kompresuje dane obrazu za pomocą (stratnego) algorytmu JPEG.

Save As (Zapisz jako)
Opcja ta działa podobnie do opcji Save (Zapisz), z tą różnicą, że
użytkownik jest proszony o podanie nazwy pliku nawet jeśli ry-
sunek został wcześniej zapisany pod prawidłową nazwą. Save as

___________________________

2 Dokonane zmiany w rysunku (nie wynikające z konwersji), o ile specjalnie

nie zapisano ich również w oryginalnym pliku, nie zostaną zapisane nigdzie

poza kopią. W takiej sytuacji, odzyskanie na przykład stanu zmienionych

warstw będzie niemożliwe, jeśli docelowy format pliku kopii nie przechowuje

takich danych — przyp. tłum.
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(Zapisz jako) pozwala na zapisanie rysunku pod inną nazwą lub
w innym formacie — wystarczy tylko podać inną nazwę lub wy-
brać inne rozszerzenie pliku.

Revert (Przywróć)
Porzuca wszystkie zmiany rysunku i przywraca jego ostatnio za-
pisaną wersję.

Mail Image (Wyślij rysunek pocztą elektroniczną)
Jest to prosty i bardzo praktyczny moduł rozszerzający pozwala-
jący na wysłanie rysunku pocztą elektroniczną bezpośrednio
z poziomu Gimpa. Należy podać tu nazwę pliku aby Gimp mógł
określić jego format. Do wysyłanego obrazu można dołączyć
również krótką wiadomość. Opcja Mail Image (Wyślij rysunek
pocztą elektroniczną) wymaga, by komputer, na którym urucho-
miony jest Gimp, posiadał działający system poczty.

Print (Drukuj)
W wersji Uniksowej dodatek ten wykorzystuje do wydruku ob-
razów kolejki drukowania. Dzięki temu nie tylko może wyko-
rzystywać PostScript, ale też i bezpośrednio porozumiewać się
z wieloma drukarkami laserowymi i atramentowymi. System
udostępniający drukarkę musi udostępniać kolejkę drukowania,
zapewniającą bezpośrednie połączenie bufora z drukarką bez
pośrednictwa filtra. Taka kolejka zazwyczaj nazywana jest ko-
lejką typu raw. Sterowniki bezpośrednie są szybsze i oferują
lepszą jakość od sterownika PostScriptowego.

Wersja Gimpa dla systemu Windows posiada moduł rozszerzają-
cy umożliwiający wykorzystywanie systemowych sterowników
drukowania i zapewniający dostęp do wszystkich dostępnych
drukarek.

Okno dialogowe drukowania pozwala na skalowanie i pozycjo-
nowanie rysunku oraz ustalanie jego jasności. Wartości domyśl-
ne są często wystarczająco dobre dla większości drukarek lase-
rowych; w przypadku drukarek atramentowych jednak może być
konieczne zwiększenie jasności wydruku.



33-94.doc 9/62

Image Window (Okno obrazu) 9

Close (Zamknij) (CTRL+W)
Zamyka rysunek. Jeśli nie zapisano ostatnio dokonanych mody-
fikacji, użytkownik zostanie zapytany, czy chce zamknąć okno
obrazu bez zachowania zmian.

Quit (Wyjdź) (CTRL+Q)
Kończy pracę Gimpa. Jeśli nie zapisano ostatnio dokonanych
modyfikacji, użytkownik zostanie zapytany, czy chce zakończyć
pracę nad rysunkiem bez zachowania zmian.

�����������	�
Menu Edit (Edycja) zawiera operacje często wykonywane przy edycji
obrazu, takie jak kopiowanie, wycinanie i wklejanie:

Undo (Cofnij) (CTRL+Z)
Jest to najważniejsza funkcja Gimpa — pozwala na cofnięcie ostat-
nio dokonanej czynności. Istnieje możliwość ustalenia liczby czyn-
ności, które będzie można cofnąć w ten sposób — szerzej omówiono
to w części „Preferences (Preferencje)”. Liczba ta jest ograniczana
tylko ilością pamięci (zarówno rzeczywistej jak i wirtualnej).

Możliwość cofnięcia efektów działania jest zapewniana przy
niemal wszystkich funkcjach Gimpa, nie licząc kilku skryptów.
Ponieważ skrypty zazwyczaj wykonują bardzo wiele czynności,
przed rozpoczęciem działania wyłączają funkcję cofania zmian.
Dlatego też nigdzie nie zostają zachowane informacje o dokony-
wanych zmianach i nie można ich odwrócić.

Redo (Ponów) (CTRL+R)
Ponawia ostatnio cofniętą czynność.

Cut (Wytnij) (CTRL+X)
Usuwa aktywną warstwę lub zaznaczony obszar zachowując wy-
cięty element w buforze kopiowania.

Copy (Kopiuj) (CTRL+C)
Kopiuje zawartość aktywnej warstwy lub zaznaczonego obszaru
do bufora kopiowania.
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Paste (Wklej) (CTRL+V)
Wkleja zawartość bufora kopiowania do rysunku w formie zaznaczo-
nego obszaru, który można przesuwać (zaznaczenia przesuwnego).

Paste Into (Wklej do)
Wkleja zawartość bufora kopiowania do rysunku w formie za-
znaczenia przesuwnego. Jeśli przed wywołaniem funkcji zazna-
czono jakiś obszar rysunku, zawartość bufora kopiowania zosta-
nie wklejona zamiast tego do zaznaczonego obszaru.

Paste as New (Wklej jako nowe)
Tworzy nowy rysunek z zawartości bufora kopiowania.

Buffer (Bufor)
Udostępnia następujące dodatkowe bufory:

Cut Named (Wytnij z nazwą) (SHIFT+CTRL+X)
Usuwa aktywną warstwę lub zaznaczony obszar i kopiuje je-
go zawartość do bufora kopiowania, opatrując go opisem
ułatwiającym wykorzystanie go w przyszłości.

Copy Named (Kopiuj z nazwą) (SHIFT+CTRL+C)
Kopiuje zawartość aktywnej warstwy lub zaznaczonego ob-
szaru do bufora kopiowania z określoną nazwą ułatwiającą
wykorzystanie go w przyszłości.

Paste Named (Wklej z nazwą) (SHIFT+CTRL+V)
Otwiera okno dialogowe ze spisem wszystkich opisanych bu-
forów. Można w nim wybrać bufor kopiowania, którego za-
wartość ma zostać wstawiona do rysunku lub usunąć bufory,
które nie są już potrzebne.

Clear (Wymaż) (CTRL+K)
Wymazuje zawartość aktywnej warstwy lub zaznaczonego obsza-
ru. Jeśli dana warstwa posiada kanał Alfa, staje się przeźroczysta;
w przeciwnym wypadku przyjmuje kolor pierwszego planu.

Fill with FG Color (Wypełnij kolorem pierwszego planu) (CTRL+,)
Wypełnia aktywną warstwę lub zaznaczony obszar kolorem
pierwszego planu.
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Fill with BG Color (Wypełnij kolorem tła) (CTRL+.)
Wypełnia aktywną warstwę lub zaznaczony obszar kolorem tła.

Stroke (Pociągnięcie pędzla)
Obrysowuje krawędź zaznaczonego obszaru za pomocą aktualnie
wybranego pędzla. Funkcja ta nieco równoważy brak przyzwo-
itych narzędzi rysowania. Połączona z narzędziami wyboru (patrz
„Narzędzia wyboru”) może tworzyć proste figury geometryczne.

Repeat and Duplicate (Powtórz i powiel) (W)
Tworzy wielokrotne kopie zaznaczonego obszaru i wkleja je do
tej samej warstwy. Można określić odległość kopii od oryginału.

Copy Visible (Kopiuj widoczne)
Kopiuje cały widoczny rysunek do bufora kopiowania. Warto
zwrócić uwagę, że tracone są wszystkie informacje o warstwach
— w buforze umieszczany jest tylko rysunek widoczny na ekra-
nie w formie pojedynczej warstwy.

��������������
Menu Select (Wybór) uzupełnia narzędzia wyboru (patrz „Narzedzia
wyboru”) o funkcje edycji zaznaczeń:

Invert (Odwróć) (CTRL+I)
Odwraca zaznaczenie. Wszystko co nie było wcześniej zazna-
czone wchodzi w skład zaznaczenia i odwrotnie.

All (Wszystko) (CTRL+A)
Zaznacza całą warstwę.

None (Nic) (SHIFT+CTRL+A)
Odznacza wszystko.

Float (Przenieś) (SHIFT+CTRL+L)
Pozwala na zmianę położenia aktualnego zaznaczenia.
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Feather (Wygładź) (SHIFT+CTRL+F)
Wygładza krawędzie zaznaczenia. Można podać szerokość wy-
gładzania w pikselach.

Sharpen (Wyostrz) (SHIFT+CTRL+H)
Usuwa efekt wygładzania krawędzi zaznaczenia. Nowe krawę-
dzie pojawią się dokładnie w miejscu zaznaczenia pikseli.

Shrink (Zmniejsz)
Zmniejsza obszar zaznaczenia o liczbę pikseli podaną w oknie
dialogowym.

Grow (Powiększ)
Zwiększa obszar zaznaczenia o liczbę pikseli podaną w oknie
dialogowym.

Border (Brzeg)
Zaznacza krawędź aktualnie zaznaczonego obszaru. Można okre-
ślić szerokość obramowania w pikselach.

Save to Channel (Zapisz do kanału)
Pozwala zachować obszar zaznaczenia do późniejszego wykorzysta-
nia. Obszar zaznaczenia jest zapisywany w kanale i pojawia się
w oknie dialogowym Channel (Kanały) (<Image>Dialogs→Layers,
Channels&Paths (<Obrazek>Menu dialogowe→Warstwy, kanały
i ścieżki)). Można go przywrócić za pomocą polecenia Channel to
Selection (Zaznacz zgodnie z kanałem).

By Color (Poprzez kolor)
Zaznacza wszystkie piksele o tych samych (i podobnych) kolo-
rach oraz otwiera okno dialogowe za pomocą którego można
wybrać tryb zaznaczania (Selection Mode). W oknie tym można
określić w jaki sposób nowy obszar zaznaczenia będzie łączony
z istniejącym zaznaczeniem. Dostępne tryby to Replace (Zastąp),
Add (Dodaj), Substract (Odejmij), oraz Intersect (Przetnij). To
narzędzie wyboru nie jest dostępne z poziomu przybornika.

Suwak Fuzziness Threshold (Próg tolerancji) określa maksymal-
ną różnicę koloru pomiędzy zaznaczonym pikselem a innymi
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pikselami, przy której piksele te będą traktowane tak, jakby
miały ten sam kolor. Rysunek wybiera się poprzez kliknięcie go.
Narzędzie to będzie aktywne do chwili wybrania innego narzę-
dzia lub zamknięcia okna dialogowego.

Round (Zaokrąglaj) (W)
Zaokrągla w podanym stopniu krawędzie zaznaczenia.

To Path (Do ścieżki)
Dokonuje konwersji zaznaczenia do krzywej Beziera, którą moż-
na edytować za pomocą narzędzia Path (Ścieżki).

 �����������
Menu View (Widok) zapewnia dostęp do opcji pozwalających kontro-
lować wygląd ekranu. Funkcje te nie zmieniają rysunków — zmienia
się tylko sposób ich wyświetlania:

Zoom in (Powiększ) (=)
Powiększa rysunek o jeden etap.

Zoom out (Pomniejsz) (-)
Pomniejsza rysunek o jeden etap.

Zoom (Przybliż) (1)
Menu to pozwala ustalić poziom zbliżenia od 1:16 do 16:1 oraz
przypisywać skróty klawiaturowe dla określonych zbliżeń. Na
przykład stopniu powiększenia 1:1 domyślnie odpowiada skrót
klawiaturowy 1. Więcej informacji na temat tworzenia własnych
skrótów klawiaturowych można znaleźć w części „Tworzenie
i edycja skrótów klawiaturowych”.

Dot for Dot (Punkt dla punktu)
Jeżeli opcja ta jest aktywna a aktualny poziom powiększenia
ustawiono na 1:1, każdy piksel ekranu reprezentuje jeden piksel
rysunku. Tryb ten jest bardzo użyteczny w trakcie tworzenia lub
edycji ikon lub też grafiki internetowej.
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Z drugiej strony, jeśli pracuje się nad rysunkiem, który ma zostać
wydrukowany, znacznie ważniejsze są prawdziwe wymiary ry-
sunku i opcja ta powinna zostać wyłączona. Dzięki temu Gimp
będzie wyświetlał rysunek oraz drukował go zgodnie z rozdziel-
czością ekranu i rysunku. Rozdzielczość i jednostki wykorzysty-
wane przy wyświetlaniu informacji o pozycji wskaźnika myszy
(na przykład cale bądź milimetry) można zmienić za pomocą
opcji <Image>Image→Scale Image (<Obrazek>Obrazek→Skaluj
obrazek). Jeśli chce się uzyskać dokładne przedstawienie rozmia-
rów rysunku, należy odpowiednio ustawić rozdzielczość ekranu
w menu Preferences (Preferencje) (patrz część „Preferences (Pre-
ferencje)”).

Info Window (Informacje o oknie) (SHIFT+CTRL+I)
Wyświetla następujące informacje o rysunku: rozmiar w pikse-
lach i wymiary rzeczywiste, rozdzielczość rysunku, aktualny sto-
pień powiększenia, typ rysunku oraz rozdzielczość ekranu.

Nav. Window (Nawigacja oknem) (SHIFT+CTRL+N)
Wyświetla miniaturę całego rysunku z obramowanym na biało
obszarem, który jest aktualnie widoczny. Obszar widoczny moż-
na przesuwać przeciągając go myszką. Do funkcji tej można
również dostać się szybciej, klikając ikoną przy prawym dolnym
roku każdego okna obrazu.

Toggle Selection (Zaznaczenie) (CTRL+T)
Przełącza widoczność zaznaczenia i krawędzi warstw. Jest to uży-
teczne gdy chce się przyjrzeć rysunkowi bez przeszkadzających linii.

Toggle Rulers (Linijki) (SHIFT+CTRL+R)
Przełącza widoczność linijek. Jednostką linijek mogą być piksele
lub, jeśli nie jest aktywna opcja Dot for Dot (Punkt dla punktu),
wykorzystywana przy danym rysunku jednostka rzeczywista.

Toggle Statusbar (Pasek stanu) (SHIFT+CTRL+S)
Przełącza widoczność paska stanu w oknie obrazu.
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Toggle Guides (Prowadnice) (SHIFT+CTRL+T)
Przełącza widoczność linii przewodnich.

Snap to Guides (Przyciągaj do linii przewodnich)
Powoduje, że linie przewodnie „przyciągają” warstwy, dzięki
czemu rozmieszczanie warstw wzdłuż linii przewodnich staje się
znacznie prostsze.

New View (Nowy widok)
Otwiera nowe okno z tym samym rysunkiem. Funkcje tę najczę-
ściej wykorzystuje się chcąc mieć okno robocze z dużym po-
większeniem oraz okno, w którym będzie można równocześnie
obserwować cały rysunek.

Shrink Wrap (Dostosuj do rozmiaru) (CTRL+E)
Dostosowuje okno tak, by, jeśli jest to możliwe, wyświetlany był
cały rysunek. Uaktywnienie opcji Allow Window Resizing (Ze-
zwalaj na zmianę rozmiaru okna) narzędzia Zoom (Powiększ)
sprawi, że funkcja ta będzie automatycznie wywoływana przy
każdej zmianie poziomu powiększenia.

!"	����#��	����

Menu Image (Obrazek) zapewnia dostęp do opcji uzupełniających
funkcje przybornika (patrz dział „Narzędzia transformacji”), pozwala-
jących na modyfikowanie kolorów, przeprowadzanie transformacji ry-
sunku oraz zmianę jego formatu.

��������	
�

Gimp pozwala pracować z różnymi formatami rysunków, z których
każdy może wyświetlać różną liczbę kolorów. Funkcje menu Mode
(Tryb) umożliwiają dokonanie konwersji rysunku do innego formatu
(więcej informacji o formatach rysunków można znaleźć w części
„Formaty plików”):
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RGB (RGB) (ALT+R)
Dokonuje konwersji rysunku do modelu kolorów RGB (red
— czerwony, green — zielony, blue — niebieski). Ponieważ
większość filtrów i skryptów współpracuje tylko z tym modelem
kolorów, ten tryb rysunku zapewnia największe możliwości.

Grayscale (Odcienie szarości) (ALT+G)
Dokonuje konwersji rysunku do skali szarości, wyświetlając do
256 różnych odcieni koloru szarego.

Indexed (Indeksowany) (ALT+I)
Dokonuje konwersji rysunku do indeksowanego modelu kolo-
rów. W trybie tym rysunek wykorzystuje paletę o określonej
liczbie kolorów. Jeśli nie podano żadnej liczby, wykorzystywana
jest maksymalna wartość 256 barw. Przy uaktywnionej opcji
Remove Unused Colors From Final Palette (Usuwaj niewykorzy-
stywane kolory z palety końcowej) lub też gdy ustawiono doce-
lowo mniejszą liczbę kolorów od liczby rzeczywiście używa-
nych, paleta będzie zawierała tylko kolory wykorzystywane
w rysunku. Okno dialogowe oferuje również zastosowanie WWW
Optimized Palette (Palety zoptymalizowanej dla stron WWW), któ-
rą można wybrać chcąc użyć palety 216 kolorów „bezpiecznych
dla sieci”. Zmniejszenie liczby kolorów powoduje wystąpienie wy-
raźnych „schodów” przy gradientach. Schody te można w pewnym
stopniu ukryć wybierając opcję rozpraszania koloru (Dithering).
Dostępne są następujące algorytmy rozpraszania kolorów:

Floyd-Steinberg Color Dithering (normal)
(Rozpraszanie metodą Floyda-Steinberga (standardowe))

Opcja ta udostępnia metodę rozpraszania optymalną dla więk-
szości rysunków.

Floyd-Steinberg Color Dithering (reduced color bleeding) (Rozpraszanie
metodą Floyda-Steinberga
(o zredukowanym mieszaniu koloru))

W pewnych sytuacjach algorytm ten pozwala na osiąganie
lepszych rezultatów od standardowego algorytmu rozprasza-
nia metodą Floyda-Steinberga.
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Positioned Color Dithering
(Pozycjonowane rozpraszanie koloru)

Dobrze dostosowane do potrzeb animacji, ponieważ, w prze-
ciwieństwie do metody Floyda-Steinberga, nie będzie wy-
woływało migotania.

Ponieważ format GIF posiada tylko jednobitowy kanał Alfa, pik-
sele mogą być albo w pełni przeźroczyste albo w pełni nieprzeźro-
czyste. Wrażenie półprzeźroczystości można tworzyć za pomocą
opcji Enable Dithering of Transparency (Włącz rozpraszanie prze-
źroczystości). W tym wypadku jednak lepsze rezultaty można
osiągać za pomocą modułu rozszerzającego Semi-Flatten (patrz
punkt „Colors (Kolory)” w dziale „Filters (Filtry)”) stosowanego
przed konwersją rysunku do formatu indeksowanego.

Gimp zapewnia tylko ograniczoną obsługę formatu indeksowa-
nego (wiele modułów rozszerzających współpracuje tylko z ry-
sunkami w trybie RGB). Ogólnie, zalecane jest, by po otwarciu
pliku o indeksowanych kolorach, na przykład w formacie GIF,
przekonwertować go do formatu RGB, dokonać odpowiednich
modyfikacji i ponownie przekonwertować go do trybu indekso-
wanego tuż przed zapisaniem zmian.

Compose (Złożenie)
Składa kolorowy rysunek ze zbioru rysunków w odcieniach szaro-
ści, w którym każdy rysunek jest obrazem jednego z kanałów do-
celowego rysunku RGB. W zależności od wykorzystanego modelu
kolorów (patrz część „Modele koloru”) możesz potrzebować do
czterech obrazów w odcieniach szarości. Muszą mieć one te same
wymiary, ale mogą być warstwami pojedynczego rysunku.

Decompose (Rozkładanie)
Tworzy zbiór obrazów w odcieniach szarości z kolorowego rysun-
ku. W przypadku rysunków w trybie RGB, otrzymywane obrazy
odpowiadają tym, które można zobaczyć w oknie dialogowym
Channel (Kanały) (patrz dział „Layers (Warstwy)”). W przypadku
rysunków w trybie CMYK można dokonać oddzielenia kolorów
dla druku w celach profesjonalnych. Tym niemniej profesjonalne
drukarki z odpowiednio skalibrowanym oprogramowaniem i sprzę-
tem pozwalają osiągnąć znacznie lepsze rezultaty.
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Poniższe funkcje pozwalają na manipulowanie kolorami aktywnej
warstwy:

Color Balance (Balans kolorów)
Pozwala na dokonanie kontrolowanej zmiany kolorów. Trzy su-
waki odpowiadające trzem podstawowym kolorom (RGB) po-
zwalają na odpowiednie ustawienie nasycenia każdego z nich.
Wybierając odpowiedni przycisk można oddzielnie ustawić na-
sycenia dla cieni (Shadows), półcieni (Midtones) i światła (Hi-
ghlights). Opcja Preserve Luminosity (Utrzymaj luminancję) za-
pobiega zmianom jasności pikseli idącym za zmianami koloru.

Hue-Saturation (Odcień i nasycenie)
Zarządza barwą (Hue), luminancją (Luminosity) oraz nasyceniem
(Saturation) rysunku. Jeżeli uaktywniono przycisk Master zmiany
będą dotyczyć wszystkich kanałów w tym samym stopniu. Wybie-
rając tylko jeden kanał można na przykład zamienić wszystkie od-
cienie czerwieni rysunku na odcienie koloru zielonego.

Brightness-Contrast (Jasność i kontrast)
Umożliwia zmianę jasności i kontrastu rysunku. Zazwyczaj jednak
lepsze rezultaty można osiągnąć za pomocą opcji Levels (Poziomy)
lub Curves (Krzywe) (obie znajdują się w tym samym menu).

Threshold (Próg)
Dokonuje konwersji rysunku do czerni i bieli (nie odcieni szarości).
Wyświetlany jest tu użyteczny histogram, za pomocą którego moż-
na ustalić jakie wartości będą reprezentowane przez biały kolor.

Levels (Poziomy)
Pozwala na modyfikację zakresu tonalnego rysunku. W oknie
dialogowym można zobaczyć użyteczny histogram z trzema
znacznikami poniżej. Za pomocą znaczników tych określa się,
jakie wartości mają przypadać kolorowi czarnemu, kolorowi sza-
remu w 50% oraz białemu. Odpowiednie wartości wyświetlane
są u góry jako Input Values (Poziomy wejścia). Środkowe pole
zawiera wartość jasności i jest związane z położeniem szarego
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trójkąta. Można również modyfikować wartości wyjściowe. Od-
powiednie pola znajdują się w dolnej części okna dialogowego.

Za pomocą opcji Levels (Poziomy) można nie tylko zmieniać
wartości ogólne ale i również wartości dowolnego kanału kolo-
rów, łącznie z kanałem Alfa. Odpowiedni kanał można wybrać
z menu u góry okna dialogowego.

Curves (Krzywe)
Podobnie jak Levels (Poziomy), polecenie Curves (Krzywe) po-
zwala na modyfikację zakresu tonalnego rysunku. Wartości na osi
poziomej są mapowane na wartości na osi pionowej. W celu za-
pewnienia lepszej orientacji istnieje możliwość kliknięcia rysunku
— spowoduje to pokazanie jasności wybranego piksela na osi po-
ziomej. Samo w sobie mapowanie jest reprezentowane w postaci
niewielkiego prostokąta poniżej krzywej. Krzywą można zmieniać
poprzez przeciąganie znaczników sterujących. Nowe znaczniki
można umieszczać po prostu klikając w wybrane miejsce krzywej.
Aby usunąć znacznik sterujący należy przeciągnąć go do innego
znacznika. Narzędzie to posiada również tryb pozwalający na
ręczne rysowanie krzywych, bez udziału znaczników sterujących
(Curve Type: Free (Typ krzywej: Dowolny)).

Za pomocą menu Curves (Krzywe) można ustalać nie tylko war-
tości dla całego obrazu, ale też i dla każdego kanału koloru
z osobna, łącznie z kanałem Alfa. Modyfikowany kanał można
wybrać za pomocą górnego menu.

Desaturate (Desaturacja)
Usuwa wszystkie kolory z rysunku — w wyniku działania tej
opcji otrzymuje się rysunek w skali szarości nadal jednak będący
w trybie RGB. Po wykonaniu funkcji można kontynuować edy-
cję rysunku z wykorzystaniem kolorów.

Invert (Odwrócenie)
Odwraca kolory rysunku. Jasne piksele stają się ciemnymi i vice
versa, wszystkie barwy zaś zostają zastąpione swoimi przeci-
wieństwami.
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Posterize (Posteryzacja)
Redukuje liczbę wykorzystywanych kolorów. Za pomocą pola
Levels (Poziomy) można określić ile wartości może przybrać
każdy z kanałów koloru. Łagodne gradienty zmieniają się w pa-
ski z tego samego koloru.

Auto (Automatycznie)
Funkcje te automatycznie dostrajają kolory i kontrast rysunku:

Equalize (Wyrównaj)
Modyfikuje kolory tak, by wszystkie wartości intensywności
występowały z przybliżoną częstotliwością. W rezultacie
uzyskuje się lepszy kontrast, może to jednak prowadzić rów-
nież do poważnych zmian kolorów. Lepsze rezultaty uzy-
skuje się za pomocą funkcji Stretch Contrast i Stretch HSV.

Color Enhance (Uwydatnij kolor)
Uwydatnia kontrast koloru poprzez rozszerzenie nasycenia
barw, dzięki czemu wykorzystywany jest cały dostępny za-
kres. Barwy pozostają niezmienione.

Normalize (Normalizuj)
Kolejna funkcja polepszająca kontrast, która, w przeciwień-
stwie do funkcji Stretch Contrast, rozszerza wszystkie kanały
koloru o tę samą wartość. Takie rozwiązanie wyklucza moż-
liwość wystąpienia przekłamań kolorów.

Stretch Contrast
Zwiększa kontrast pomiędzy zakresami koloru rysunku. Po-
nieważ operacja ta jest przeprowadzana odrębnie dla każdego
kanału koloru, mogą wystąpić przekłamania barw.

Stretch HSV
Również zwiększa kontrast rysunku, ale robi to, operując
w przestrzeni kolorów HSV (patrz „Modele kolorów”). Bar-
wy pozostają niezmienione.

Colormap Rotation (Rotacja mapy koloru)
Mapuje całe zakresy kolorów na inne. Za pomocą opcji Color-
map Rotation (Rotacja mapy koloru) można na przykład zmienić
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kolor jakiegoś elementu ubrania na zdjęciu, nie zmieniając przy
tym innych kolorów.

Filter Pack (Zbiór filtrów)
Zbiór filtrów do manipulacji obrazem dostępnych poprzez bar-
dzo intuicyjne okno dialogowe. Opcja ta wyświetla dookoła
miniatury oryginalnego rysunku miniatury jego wariacji, nie-
znacznie różniących się barwą, nasyceniem i jasnością. Klik-
nięcie jednej z miniatur umieszcza ją w centrum grupy, dzięki
czemu można łatwo dojść do zamierzonego wyglądu obrazu
metodą małych kroków. Aby cofnąć ostatni wybór należy po
prostu kliknąć na miniaturę będącą przeciwieństwem tej wy-
branej poprzednio.

�
������������
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Poniższe funkcje menu Alpha pozwalają na manipulację kanałem prze-
źroczystości rysunków:

Add Alpha Channel (Dodaj kanał Alfa)
Dodaje do obrazu kanał Alfa. Ta sama funkcja dostępna jest
również w menu <Image>ImageAlpha→Add Alpha Channel
(<Obrazek>ImageAlpha→Dodaj kanał Alfa).

Clear Alpha (Oczyść kanał Alfa) (W)
Jeśli części rysunku nadano atrybut przeźroczystości za pomocą
kanału Alfa, informacje o tej zawartości rysunku nadal są do-
stępne i mogą zostać odzyskane za pomocą funkcji Anti-Erase
gumki. Omawiany skrypt Perla wypełnia wszystkie przeźroczy-
ste obszary ustalonym kolorem. Dzięki temu funkcja ta w połą-
czeniu z algorytmami kompresji różnych formatów graficznych
pozwala zmniejszyć rozmiar pliku rysunku.

Threshold Alpha (Ustal próg dla kanału Alfa)
Funkcja ta działa analogicznie jak funkcja Threshold, dostępna
pod <Image>Image→Colors→Threshold (<Obrazek>Obrazek
→Kolory→Próg) ale dotyczy tylko kanału Alfa. Wszystkie pik-
sele z atrybutem przeźroczystości poniżej zadanego progu staną
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się całkowicie przeźroczyste; wszystkie piksele powyżej zadane-
go progu zaś całkowicie nieprzeźroczyste.

��������������������������

Funkcje w tym menu pozwalają na zmienianie rysunków poprzez po-
ruszanie ich lub obracanie:

Offset (Przesuń) (SHIFT+CTRL+O)
Przesuwa warstwę w pionie lub poziomie o określoną liczbę pik-
seli. W przeciwieństwie do Move Tool (Przesunięcie), warstwa
zostaje przycięta na krawędzi rysunku. Za pomocą opcji Wrap
Around (Zawiń) można ustalić, w jaki sposób mają być trakto-
wane elementy rysunku, które wyszły poza obszar obrazu. Jeżeli
opcja ta jest aktywna, część warstwy, która wyjdzie poza obręb
obrazu z jednej strony, pojawi się po przeciwnej stronie rysunku.
Funkcja Offset By (X/2), (Y/2) (Przesunięcie o (X/2), (Y/2)) pozwala
na łatwe tworzenie zazębiających się obrazów (tapet), ponieważ
sprawia że narożniki są przenoszone do centrum obrazu i mogą
być ze sobą bez problemu złożone.

Rotate (Obróć)
Obraca cały rysunek o wielokrotność 90 stopni. Funkcja ta nie
działa przypadku rysunków zawierających maski i kanały. Do
obracania pojedynczych warstw służy funkcja <Image>Layers
→Rotate (<Obrazek>Warstwy→Obróć).

Autocrop (Auto przytnij)
Moduł ten automatyzuje funkcję Crop. Autocrop (Auto przytnij)
analizuje wszystkie warstwy rysunku i przycina jednolite kolory (na
przykład miejsca, w których obraz jest pusty) pozwalając w łatwy
i szybki sposób przyciąć rysunek do minimalnych wymiarów.

Opisywany moduł rozszerzający przycina wszystkie warstwy, ale
punkty przycinania wyszukuje tylko w warstwach aktywnych, przez
co mogą zostać utracone elementy rysunku w innych warstwach.
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Guillotine (Gilotyna)
Dzieli rysunek zgodnie z wszystkimi liniami przewodnimi usta-
wionymi za pomocą narzędzia Move, tworząc zbiór mniejszych
rysunków. Może być to dość przydatne przy tworzeniu rysun-
ków, które docelowo mają być wyświetlane w tabelach HTML.

Zealous Crop (Przytnij zdecydowanie)
Podobnie jak Autocrop (Auto przytnij), funkcja Zealous Crop
(Przytnij zdecydowanie) przycina obszary o tym samym kolorze
(na przykład puste miejsca). W przypadku tej funkcji przycinane
są jednak nie tylko obszary na krawędziach ale również, o ile jest
to możliwe, obszary wewnątrz rysunku. Ponieważ funkcja ta
operuje na całym obrazie, ale punkty przycinania wyszukuje tyl-
ko w warstwach aktywnych, jej wykonanie może zaowocować
utraceniem elementów rysunku.

Canvas Size (Rozmiar obszaru roboczego)
Zmienia rozmiar rysunku nie przeprowadzając przy tym skalo-
wania. Warstwy które przy tej operacji wyjdą poza krawędzie
obrazu nie zostaną przycięte. Aby tego dokonać należy skorzy-
stać z narzędzia Crop&Resize (patrz punkt „Crop & Resize (Ka-
drowanie lub zmiana rozmiaru) (SHIFT+C)”). Funkcja Resize
(Zmień rozmiar) powiększa rysunek tak, by zmieściły się na nim
warstwy uprzednio wykraczające poza jego obręb.

Jeżeli aktywna jest opcja Constrain Ratio (Zachowaj proporcje)
szerokość i wysokość rysunku zostaje zwiększona w tym samym
stopniu, zachowując proporcje obrazu. Aby na przykład podwoić
rozmiar rysunku należy tu wpisać wartość 2.0.

Opcje X i Y Offset (Przesunięcie X i Y) w dolnej części okna dia-
logowego pozwalają na zmianę i dokładne ustalenie położenia
rysunku w jego nowych wymiarach.

Scale Image (Rozmiar rysunku)
Umożliwia zmianę rozmiaru rysunku; skalowanie dotyczy wszyst-
kich warstw i kanałów obrazu. Nowy rozmiar może być bezpo-
średnio podany w pikselach, lub też w postaci mnożnika w polach
X i Y Offset. Przykładowo, podanie mnożnika 0.5 w polu Y Offset
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zmniejsza wysokość rysunku o połowę. Aby zmienić rozmiar
pojedynczej warstwy należy skorzystać z opcji Scale Layer
(Skaluj warstwę) w oknie dialogowym Layers (Warstwy) (<Image>
Dialogs→Layers, Channels&Paths (<Obrazek>Okna dialogowe
→Warstwy, kanały i ścieżki)).

W dolnej części okna dialogowego znajdują się opcje pozwalają-
ce na zmianę rozdzielczości rysunku. Nie powoduje to jednak
przeskalowania zawartości rysunku — opcje te wpływają wy-
łącznie na rozmiar rysunku w druku.

Duplicate (Zduplikuj) (CTRL+D)
Powiela cały rysunek, łącznie ze wszystkimi warstwami, kana-
łami, ścieżkami itp.

Histogram (Histogram)
Wyświetla histogram intensywności obrazu oraz informacje o ob-
szarze oznaczonym przez wskaźnik.

$	���%���	�%����

Z kilkoma wyjątkami, wszystkie funkcje tego menu są również dostęp-
ne w oknie dialogowym Layers (Warstwy) (<Image>Dialogs→Layers,
Channels&Paths) (<Obrazek>Okna dialogowe→Warstwy, kanały i ścież-
ki), opisanego w punkcie „Layers (Warstwy)”. Pomimo to postanowili-
śmy przedstawić w jaki sposób można zaznaczać i przenosić warstwy
bez wykorzystywania tego okna. Funkcje te można również wywoły-
wać za pomocą skrótów klawiaturowych, co przyspiesza pracę z ry-
sunkami zawierającymi wiele warstw:

Rotate (Obróć)
Obraca wybraną warstwę o wielokrotność 90 stopni. Teoretycznie
można zrobić to samo za pomocą narzędzi transformacji (patrz
dział „Narzędzia wyboru”), ale wykorzystywany tu algorytm jest
specjalnie zoptymalizowany dla 90 stopni i działa o wiele szybciej
od polecenia Transform (Transformacje).



33-94.doc 25/62

Image Window (Okno obrazu) 25

Center Layer (Wyśrodkuj warstwę) (W)
Umieszcza aktualną warstwę w środku rysunku.

Align Visible Layers (Rozmieść widoczne warstwy)
Pomaga rozmieścić wszystkie warstwy za pomocą różnych opcji
rozmieszczania.

&���%��'	��
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Do narzędzi Gimpa można łatwo dostać się poprzez ikony Toolbox
(Przybornika). Menu to istnieje wyłącznie po to, by umożliwić łatwe
przypisanie poszczególnym narzędziom skrótów klawiaturowych (wię-
cej informacji na ten temat można znaleźć w części „Tworzenie i edy-
cja skrótów klawiaturowych”).

(�	���%��#�
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Za pomocą okien dialogowych menu Dialogs można modyfikować
większość ustawień Gimpa. Dokonane zmiany wprowadzane są w życie
na bieżąco. Okna dialogowe mogą pozostawać otwarte podczas pracy
nad rysunkiem. Wszystkie okna są również dostępne z poziomu menu
przybornika (<Toolbox>File→Dialogs (<Przybornik>Plik→Okna dialo-
gowe)) za wyjątkiem Undo History (Historia) dostępnego tylko z menu
Image (Obrazek) (<Image>Dialogs→Undo History (<Obrazek>Okna
dialogowe→Historia)).

��	�����������
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Największym atutem Gimpa jest możliwość dodawania do rysunków
warstw, kanałów i ścieżek. Okno dialogowe Layers, Channels&Paths
(Warstwy, kanały i ścieżki) powinno zawsze być otwarte, ponieważ
korzysta się z niego bardzo często. Menu u góry omawianego okna
pozwala na wybranie jednego z aktualnie otwartych rysunków. Po wy-
braniu go, w oknie dialogowym wyświetlane zostają jego warstwy,
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kanały i ścieżki. Rysunek można również wybrać naciskając CTRL+L
w aktywnym oknie obrazu. Po wybraniu opcji Auto, Gimp będzie po-
dążał za aktualnie aktywnym rysunkiem i odpowiednio uaktualniał in-
formacje w oknie Layers (Warstwy). Rysunek staje się aktywny z chwilą
przeprowadzenia na nim jakiejś operacji. Na przykład, w chwili gdy
okno obrazu jest aktywne, wystarczy nacisnąć spację by rysunek
w danym oknie również stał się aktywny.

��	�����������	�
W zakładce Layers (Warstwy) można zobaczyć hierarchię warstw ry-
sunku. Na prawo od warstwy wyświetlana jest jej nazwa. Aby zmienić
nazwę warstwy należy dwukrotnie kliknąć nazwę dotychczasową.

Najniższa nazwa standardowo nazywana jest Background (Tło). Nie
można przenieść jej wyżej w hierarchii o ile nie posiada przypisanego
kanału Alfa. W chwili przypisania kanału Alfa (Add Alpha Channel)
warstwa tła jest zamieniana na zwyczajną warstwę, którą można prze-
nosić w górę hierarchii.

Sposób w jaki kolory warstwy wpływają na kolory innych warstw
można ustalić za pomocą menu Mode. Szerzej wyjaśniono to w części
„Tryby rysowania i warstwy”. Opcja Keep Transparency (Utrzymaj
przeźroczystość) określa, czy przeźroczystość warstwy ma być zacho-
wywana w każdej sytuacji. Opcja Opacity (Nieprzeźroczystość) za-
pewnia kontrolę nad stopniem przeźroczystości kolorów warstwy.

Jeżeli na rysunku nie ma żadnego zaznaczenia przesuwnego (tzw. flo-
ating selection), kliknięcie warstwy automatycznie zaznacza ją i sprawia,
że staje się aktywna. Zaznaczenie przesuwne w praktyce jest samo
w sobie tymczasową warstwą, zawsze położoną na szczycie hierarchii
warstw — posiada własną ikonę i etykietę Floating Selection. Zazna-
czenie przesuwne jest tworzone w chwili przesunięcia zwykłego za-
znaczenia, wstawienia tekstu do rysunku lub też bezpośredniej kon-
wersji zaznaczenia standardowego za pomocą polecenia <Image>
Select→Float (<Rysunek>Zaznaczenie→Przesuwne). Warstwa zazna-
czenia przesuwnego jest połączona z warstwą źródłową; można ją jed-
nak zamienić na warstwę niezależną, usunąć lub zakotwiczyć (połą-
czyć) z warstwą źródłową.



33-94.doc 27/62

Image Window (Okno obrazu) 27

Znajdująca się obok warstwy ikona oka sygnalizuje jej widoczność. Wi-
doczność warstwy można przełączać klikając tę ikonę. Jeżeli przy klik-
nięciu ikony zostanie przytrzymany klawisz SHIFT, przełączana jest
równocześnie widoczność wszystkich innych warstw — dzięki temu
można w łatwy sposób wyświetlić na ekranie tylko jedną warstwę.

Warstwy mogą być również ze sobą połączone. Połączenie sygnalizuje
ikona krzyżyka obok ikony oka. Wszystkie połączone warstwy są prze-
suwane równocześnie, dzięki czemu ich położenie wobec siebie pozo-
staje niezmienione.

Po zdefiniowaniu masek warstw potrzebne są dodatkowe funkcje. Ma-
ska warstwy wzbogaca obraz o kolejny kanał przeźroczystości. Sama
w sobie maska jest obrazem w skali szarości o takich samych wymia-
rach co warstwa. Czarne piksele maski oznaczają że w danym miejscu
warstwa jest w pełni przeźroczysta, białe natomiast oznaczają pełną
nieprzeźroczystość. Kliknięcie maski warstwy zaznacza ją do edycji.
Edycja maski przebiega dokładnie tak samo, jak każdej normalnej war-
stwy o oknie obrazu. Aby wyłączyć działanie maski należy kliknąć ją
przytrzymując przy tym klawisz CTRL. W takiej sytuacji maska jest ozna-
czana w oknie dialogowym czerwoną obwódką. Aby zobaczyć w oknie
obrazu samą maskę, należy wybrać ją przytrzymując przy tym klawisz
ALT. Ten tryb oznaczany jest w oknie dialogowym zieloną obwódką.

Kliknięcie prawym przyciskiem myszy na wyświetlaną hierarchię warstw
otwiera menu z opcjami służącymi do manipulacji warstwami. Do niektó-
rych z najczęściej używanych funkcji można dotrzeć również za pomocą
ikon umieszczonych poniżej hierarchii warstw. Ikony te również można
wykorzystać przy operacjach typu „przeciągnij i upuść”. W zależności
od tego, na którą z ikon zostanie upuszczona dana warstwa, przepro-
wadzana jest jedna z akcji opisanych w tabeli 3.

Tabela 3. Kombinacje klawiatura-mysz

Miejsce upuszczenia warstwy Działanie
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Pomiędzy warstwami Warstwa jest wstawiana pomiędzy warstwy.

Na ikonę New Layer (Nowa warstwa) Tworzona jest nowa warstwa
o tych samych wymiarach.

Na ikonę Copy Layer (Kopiuj warstwę) Tworzona jest kopia warstwy.

Na ikonę Garbage Can (Kosz na śmieci) Warstwa zostaje usunięta.

Na inne okno obrazu Kopia warstwy wstawiana jest do danego
obrazu.

Na Toolbox (Przybornik) Tworzony jest nowy rysunek z kopii
przeciągniętej warstwy.

New Layer (Nowa warstwa) (CTRL+N)
Dodaje nową warstwę lub konwertuje do warstwy zazna-
czenie przesuwne.

Raise Layer (Przenieś wyżej) (CTRL+F)
Przenosi aktywną warstwę o jeden poziom wyżej w hie-
rarchii.

Shift+ Layer to Top (Przenieś na szczyt) (SHIFT+CTRL+F)
Przenosi aktywną warstwę na szczyt hierarchii warstw.
Można to również zrobić trzymając klawisz SHIFT przy
klikaniu ikony.

Lower Level (Przenieś niżej) (CTRL+B)
Przenosi aktywną warstwę o jeden poziom niżej w hie-
rarchii.

Shift+ Layer to Bottom (Przenieś na dno) (SHIFT+CTRL+B)
Przenosi aktywną warstwę na dno hierarchii warstw.
Można to również zrobić trzymając klawisz SHIFT przy
klikaniu ikony.

Duplicate Layer (Powiel warstwę) (CTRL+C)
Tworzy kopię aktywnej warstwy tuż obok niej samej.

Anchor Layer (Zakotwicz warstwę) (CTRL+H)
Scala istniejące zaznaczenie przesuwne z przypisaną mu
warstwą.
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Delete Layer (Usuń warstwę) (CTRL+X)
Usuwa aktywną warstwę lub zaznaczenie przesuwne.

Layer Boundary Size (Rozmiar obszaru roboczego warstwy)
(CTRL+R)

Odpowiada funkcji zmiany rozmiaru rysunku (<Image>
Image→Canvas Size (<Obrazek>Obrazek→Rozmiar ob-
szaru roboczego)). Zmienia rozmiar obszaru roboczego
warstwy nie skalując przy tym jej zawartości.

Layer to Image Size (Dopasuj rozmiar warstwy do rozmiaru
rysunku)

Dopasowuje rozmiar warstwy do rozmiaru rysunku nie
skalując przy tym jej zawartości.

Scale Layer (Skaluj warstwę) (CTRL+S)
Odpowiada funkcji skalowania obrazu (<Image>Image
→Scale Image (<Obrazek>Obrazek→Skaluj obrazek)).

Merge Visible Layers (Złącz widoczne warstwy) (CTRL+M)
Łączy wszystkie widoczne warstwy w jedną.

Merge Down (Złącz w dół) (SHIFT+CTRL+M)
Łączy warstwę bieżącą z warstwą położoną bezpośrednio
poniżej niej.

Flatten Image (Spłaszcz rysunek)
Podobnie jak Merge Visible Layers (Złącz widoczne war-
stwy), funkcja ta łączy ze sobą wszystkie widoczne war-
stwy, równocześnie jednak usuwając wszystkie warstwy
niewidoczne i kanały przeźroczystości. Przeźroczyste
piksele są łączone z danym kolorem tła. W rezultacie
otrzymuje się rysunek składający się tylko z jednej war-
stwy bez żadnego kanału Alfa.

Add Layer Mask (Dodaj maskę warstwy)
Dodaje maskę do aktywnej warstwy. Maska może być
czarna (przeźroczysta), biała (nieprzeźroczysta) lub też
odpowiadać kanałowi Alfa warstwy.
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Apply Layer Mask (Zastosuj maskę warstwy)
Łączy kanał Alfa warstwy z maską (która w związku
z tym zostaje usunięta).

Delete Layer Mask (Usuń maskę warstwy)
Usuwa maskę warstwy bez stosowania jej.

Mask to Selection (Zaznacz zgodnie z maską)
Zaznacza zgodnie z maską warstwy.

Add Aplha Channel (Dodaj kanał Alfa)
Dodaje możliwość nadania przeźroczystości danej warstwie.

Alpha to Selection (Zaznacz zgodnie z kanałem Alfa)
Zaznacza zgodnie z przeźroczystością warstwy (kana-
łem Alfa).

Edit Layer Atributes (Zmień atrybuty warstwy)
Otwiera okno dialogowe za pomocą którego można
zmienić nazwę warstwy.
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W zakładce Channels (Kanały) można zobaczyć kanały rysunku. W przy-
padku rysunków w trybie RGB, można zobaczyć tu czerwony, zielony
i niebieski kanał koloru. Rysunki w trybie indeksowanym lub w skali
szarości posiadają tylko jeden kanał. Aby uaktywnić kanał należy go
kliknąć. Można również przełączać widoczność każdego z kanałów za
pomocą ikony oka. Wszystkie modyfikacje rysunku dotyczą tylko tych
kanałów, które są aktywne.

Podobnie jak maski warstw, zaznaczone obszary konwertowane do postaci
kanałów za pomocą funkcji <Image>Select→Save to Channel (<Obra-
zek>Zaznaczenie→Zapisz do kanału) są tu dodawane jako obrazy w od-
cieniach szarości. Taki kanał umożliwia edycję zaznaczeń. Kolejność ka-
nałów nie ma znaczenia. Zawartość aktywnego kanału można zmieniać
w oknie obrazu, przy czym zmiana jasności barw odzwierciedla zmianę
przeźroczystości kanału. Dwukrotne kliknięcie nazwy kanału prowadzi do
okna dialogowego umożliwiającego zmianę jego nazwy, intensywności
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oraz barwy. Funkcja Channel to Selection (Zaznacz zgodnie z kanałem)
pozwala przekonwertować kanał z powrotem do zaznaczenia. Ta metoda
zaznaczania jest również nazywana zaznaczaniem QuickMask (Szybkie
maskowanie). Szybszy dostęp do tej techniki zapewniają dwie ikony w le-
wym dolnym rogu okna obrazu (patrz „Image Window (Okno obrazu)”).

New Channel (Nowy kanał) (CTRL+N)
Tworzy nowy kanał.

Raise Channel (Przenieś wyżej) (CTRL+F)
Przenosi kanał o jeden poziom wyżej w hierarchii kanałów.

Lower Channel (Przenieś niżej) (CTRL+B)
Przenosi kanał o jeden poziom niżej w hierarchii.

Duplicate Channel (Powiel kanał) (CTRL+C)
Tworzy kopię kanału tuż obok niego samego.

Channel to Selection (Zaznacz zgodnie z kanałem) (CTRL+S)
Zaznacza odzwierciedlając intensywność kanału.

Shift+ Add to Selection (Dodaj do zaznaczenia)
Dodaje kanał do istniejącego zaznaczenia. Funkcję tę
można również uaktywnić trzymając klawisz SHIFT
przy klikaniu ikony Channel to Selection (Zaznacz
zgodnie z kanałem).

Ctrl+ Subtract from Selection (Odejmij z zaznaczenia)
Odejmuje kanał od istniejącego zaznaczenia. Funkcję tę
można również uaktywnić trzymając klawisz SHIFT
przy klikaniu ikony Channel to Selection (Zaznacz
zgodnie z kanałem).

Shift+

Ctrl+

Intersect with Selection (Przetnij zgodnie z zaznaczeniem)
Przecina zgodnie z istniejącym zaznaczeniem. Funkcję
tę można również uaktywnić trzymając klawisze SHIFT
i CTRL przy klikaniu ikony Channel to Selection (Za-
znacz zgodnie z kanałem)

Delete Channel (Usuń kanał) (CTRL+X)
Usuwa kanał.

Edit Channel Attributes (Zmień atrybuty kanału)
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Powoduje otwarcie okna dialogowego, za pomocą któ-
rego można zmienić nazwę kanału, kolor i stopień prze-
źroczystości.

�������&�!�# !�
Ścieżki to krzywe Beziera definiujące obszar zaznaczenia — tworzy
się je za pomocą narzędzia Bezier Selection (Selekcja Beziera) (więcej
informacji na ten temat można znaleźć w dziale „Narzędzia wyboru”).
Opisywane okno dialogowe zapewnia dostęp do wszystkich narzędzi
tworzenia ścieżek. U góry okna znajdują się cztery przyciski przedsta-
wiające różne funkcje edycji. Są to odpowiednio:

New Point (Nowy punkt)
Kliknięcie ikony powoduje dodanie do ścieżki nowego
punktu sterującego. Nowy punkt jest połączony z koń-
cowym punktem sterującym krzywej.

Add Point (Dodaj punkt)
Kliknięcie ikony wstawia nowy punkt sterujący pomię-
dzy dwa istniejące punkty sterujące.

Delete Point (Usuń punkt)
Kliknięcie ikony usuwa wybrany punkt sterujący z krzywej.

Edit Point (Zmień punkt)
Kliknięcie tej ikony pozwala na edycję stopnia nachyle-
nia krzywej w punkcie sterującym. Można oddzielnie
ustalić nachylenie krzywej z obu stron punktu kontrol-
nego przytrzymując klawisz SHIFT podczas jego edycji.

Poniżej przycisków znajduje się lista ścieżek, które można edytować.
Nazwę ścieżki można zmienić klikając ją dwukrotnie myszą. Kliknię-
cie pustego obszaru na lewo od podglądu powoduje pojawienie się
w tym miejscu ikony kłódki oraz związanie ścieżki z obrazem — na-
rzędzia transformacji działają w takiej sytuacji zarówno na ścieżkę jak
i obraz. Po kliknięciu ścieżki prawym przyciskiem myszy otwiera się
menu zawierające funkcje dodatkowe. Niektóre z nich można również
wywołać za pomocą ikon u dołu okna dialogowego. W skład oferowa-
nych funkcji wchodzą:
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New Path (Nowa ścieżka) (CTRL+N)
Tworzy nową, pustą ścieżkę.

Duplicate Path (Powiel ścieżkę) (CTRL+U)
Dodaje do listy kopię bieżącej ścieżki.

Path to Selection (Ścieżka na zaznaczenie) (CTRL+S)
Przekształca ścieżkę na zaznaczenie.

Selection to Path (Zaznaczenie na ścieżkę) (CTRL+S)
Przekształca istniejące zaznaczenie na ścieżkę oraz do-
daje nową ścieżkę do listy.

Stroke Path (Obrysuj ścieżkę pędzlem) (CTRL+T)
Obrysowuje ścieżkę za pomocą aktualnie wybranego
pędzla w kolorze tła.

Delete Path (Usuń ścieżkę) (CTRL+X)
Usuwa aktualnie wybraną ścieżkę.

Copy Path (Kopiuj ścieżkę) (CTRL+C)
Kopiuje aktualnie wybraną ścieżkę do bufora kopiowania.

Paste Path (Wklej ścieżkę) (CTRL+V)
Wkleja ścieżkę z bufora kopiowania do ścieżki aktual-
nej. W ten sposób można przekopiować ścieżkę pomię-
dzy dwoma różnymi rysunkami.

Import Path (Importuj ścieżkę) (CTRL+I)
Odczytuje uprzednio wyeksportowaną ścieżkę z pliku.

Export Path (Eksportuj ścieżkę) (CTRL+E)
Zapisuje aktualnie wybraną ścieżkę w pliku.

Edit Path Attributes (Zmień atrybuty ścieżki)
Pozwala zmienić nazwę ścieżki.
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Otwiera okno dialogowe z opcjami aktualnie wybranego narzędzia. To
samo można zrobić dwukrotnie klikając ikonę odpowiadającą danemu
narzędziu w Toolbox (Przybornik).

*�+�������)�(
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Opisywane okno dialogowe wyświetla spis dostępnych pędzli. Oprócz
tego pozwala również na tworzenie prostych pędzli okrągłych i elip-
tycznych — opcja ta kryje się pod przyciskiem New (Nowa). Stworzo-
ne pędzle mogą być zmieniane również później.

U góry okna dialogowego wyświetlana jest informacja o rozmiarze
i nazwie wybranego pędzla. Jeżeli pędzel nie może zostać wyświetlony
w oryginalnych wymiarach, w dolnym rogu pojawia się mały krzyżyk.
Pełny podgląd można wówczas uzyskać klikając pędzel.

Pojawienie się w prawym dolnym rogu podglądu czerwonego trójkąta
oznacza, że dany pędzel jest tak zwanym brush hose (pędzel animowany).
Pędzle animowane składają się ze zbioru wielu różnych pędzli; o tym, któ-
ry pędzel ze zbioru pojawi się na ekranie decyduje przypadek lub kierunek
poruszania się pędzla. Kliknięcie podglądu pędzla animowanego wyświetli
wszystkie dostępne pędzle w zbiorze w postaci małej animacji.

Rysowanie za pomocą pędzla przypomina stawianie stempli — obraz
pędzla jest nanoszony na obszar roboczy w równych odstępach. Je-
żeli pędzel ma regularny kształt i odstępy pomiędzy jego obrazami są
wystarczająco niewielkie, stemplowanie nie jest zauważalne. Pędzle
o nieregularnych kształtach i dużych odstępach tworzą jednak nieco-
dzienne efekty. Odstęp pomiędzy obrazami pędzla można ustawić za
pomocą opcji Spacing (Odstęp).

W zależności od ustawień Paint Options (Opcji rysowania) (patrz
część „Preferences (Preferencje)”) okno dialogowe może również
zawierać opcje Mode (Tryb) i Opacity (Przeźroczystość). W menu
Mode (Tryb) można ustalić tryb nakładania koloru. Dostępne tryby są
takie same jak w przypadku warstw i szerzej omówiono je w części
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„Tryby rysowania i warstw”. Opacity (Przeźroczystość) decyduje
o sile krycia pędzla.

Dostępne pędzle składają się z pędzli systemowych oraz pędzli dostęp-
nych w osobistych katalogach pędzli (~/.gimp-1.2/brushes). Aby utwo-
rzyć złożony pędzel wystarczy zapisać tam rysunek w prawidłowym
formacie pędzla Gimpa. Proste pędzle w odcieniach szarości są zapi-
sywane w formacie z rozszerzeniem .gbr. Pędzle kolorowe mają roz-
szerzenie .gpb a pędzle animowane kończą się rozszerzeniem .gih. Pę-
dzel animowany można stworzyć z rysunku, na którym poszczególne
pędzle wchodzące w skład pędzla animowanego są albo umieszczone
w oddzielnych warstwach albo też ustawione w rzędach. Kliknięcie
przycisku Refresh (Odśwież) zmusza Gimpa do ponownego odczytania
wszystkich pędzli w katalogach i uaktualnienia zawartości okna dialo-
gowego jeśli jest to konieczne. Pozwala to na dodawanie pędzli bez
konieczności restartowania Gimpa.

�����������(��	���,-./�%��$�%��
To okno dialogowe wyświetla wzory dostępne dla narzędzi Bucket Fill
(Wypełnianie kubełkiem) i Clone (Stempel) (patrz punkt „Clone
(Stempel) (C)”). Większość wzorów dołączonych do pakietu Gimpa
bez problemów zazębia się ze sobą, umożliwiając wypełnienie dowol-
nego obszaru bez widocznego powtarzania się tapety. Informacje
o nazwie wzoru i jego rozmiarze wyświetlane są u góry okna dialogo-
wego. Aby otworzyć okno z podglądem wzoru w pełnych wymiarach
należy kliknąć podgląd wzoru i przytrzymać przycisk myszy.

Wzór można również umieścić na rysunku przeciągając go na rysunek
środkowym przyciskiem myszy. Dzięki temu nie trzeba aktywować
narzędzia wypełnienia. (Jeżeli posiada się myszkę z tylko dwoma
przyciskami, należy przeciągnąć wzór trzymając wciśnięte oba przyci-
ski i emulując w ten sposób przyciśnięcie przycisku środkowego).

Informacje o wzorach pobierane są zarówno z katalogów ogólnosyste-
mowych jak i prywatnego katalogu ze wzorami użytkownika (~/.gimp-
1.2/patterns). Nowe wzory można dodawać umieszczając w jednym
z tych katalogów rysunki w trybie RGB w formacie wzoru Gimpa
(o rozszerzeniu .pat). Kliknięcie przycisku Refresh (Odśwież) zmusza
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Gimpa do ponownego odczytania wszystkich wzorów w katalogach, dzięki
czemu można je dodawać bez konieczności restartowania programu.

0���!������0���!���	�����$�%0�
Narzędzie Gradient (patrz dział „Blend (Gradient) (L)”) pozwala na
użycie jednego z wielu gradientów dostarczanych wraz z Gimpem.
Jednokrotne kliknięcie któregoś z gradientów w oknie dialogowym
uaktywnia go, dwukrotne kliknięcie natomiast otwiera edytora gra-
dientów. Edytor gradientów umożliwia tworzenie własnych gradientów
lub edycję tych istniejących.

W dolnej części edytora gradientów znajduje się aktualnie wybrany gra-
dient. Gradient składa się z wielu fragmentów, przy czym krawędzie
każdego z fragmentów mają przypisaną wartość przeźroczystości i kolor.
Poszczególne części znajdują się pomiędzy czarnymi znacznikami.
Kolor przechodzi płynnie od koloru jednej krawędzi do koloru drugiej.
Białe znaczniki definiują środek przejścia kolorów. Aby wybrać kolor
z gradientu jako kolor aktualnego tła lub pierwszego planu wystarczy
kliknąć go lewym przyciskiem myszy.

Niewielki obszar pod podglądem pozwala na uzyskanie dostępu do funk-
cji różnicowania. Klikniecie lewym przyciskiem myszy zaznacza seg-
ment; kliknięcie przy wciśniętym klawiszu SHIFT powoduje wstawienie
nowego segmentu. Segmenty można również przesuwać przeciągając je
myszą. Jeśli przy przeciąganiu zostanie przytrzymany klawisz SHIFT,
zawartość segmentu zostanie rozciągnięta. Dodatkowe funkcje manipu-
lacji gradientem dostępne są pod prawym klawiszem myszy.

Gradienty pobierane są zarówno z katalogów ogólnosystemowych jak
i prywatnego katalogu z gradientami użytkownika (~/.gimp-1.2/gradients).
Zwykły użytkownik (bez uprawnień roota) nie może usuwać ani zmieniać
na stałe gradientów ogólnosystemowych. Oryginalne gradienty pojawiają się
ponownie po wybraniu funkcji Refresh Gradients (Odśwież gradienty).
Nowe i skopiowane gradienty są automatycznie zapisywane w katalo-
gu użytkownika. Funkcja Save as Povray (Zapisz jako Povray) zapi-
suje aktualnie wybrany gradient w formacie, który pozwala na wyko-
rzystanie go w programie renderującym POV-Ray.
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Palety pozwalają pracować nad wieloma rysunkami z pewnością, że
wykorzystywane są w nich te same kolory. Zakładka Select (Zaznacz)
okna dialogowego Palette (Paleta) zawiera kilka predefiniowanych
palet. Paleta Named Colors zawiera najważniejsze kolory wraz z na-
zwami nadawanymi im przez X serwer. Palety Web i Visibone zawie-
rają kolory wykorzystywane przez przeglądarki internetowe i systemy
pracujące w 8-bitowej głębi barw.

Po otworzeniu zakładki Palette (Paleta) wybrana paleta zostaje wyróż-
niona. Kliknięcie koloru sprawia, że staje się on aktualnym kolorem tła
lub pierwszego planu. Można również przeprowadzać tu proste mody-
fikacje koloru. Kliknięcie prawym przyciskiem myszy otwiera menu
zawierające funkcje tworzenia, edycji i usuwania kolorów. Nowe kolo-
ry można dodawać również przeciągając je i upuszczając. Niemal
wszystkie selektory koloru w Gimpie pozwalają przeprowadzać opera-
cje typu przeciągnij-i-upuść.

W Edytorze palet można znaleźć dodatkowe funkcje edycji i tworzenia
palet — otwiera się go za pomocą przycisku Edit. Przycisk Import
umożliwia importowanie palet z otwartego rysunku lub gradientu. Je-
żeli wybrano więcej niż jedno źródło (aby to zrobić należy skorzystać
z przycisków SHIFT i CTRL) palety mogą zostać złączone za pomocą
opcji Merge.

Wszystkie palety pobierane są z prywatnego katalogu użytkownika
(~/.gimp-1.2/palettes). Palety ogólnosystemowe są kopiowane do niego
przy pierwszym uruchomieniu Gimpa, dzięki czemu użytkownik mo-
że zmieniać (i usuwać) wszystkie dostępne palety.
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Opisywane okno dialogowe zapewnia dostęp do palety rysunków
w trybie indeksowanym (patrz „Modele kolorów”). Kliknięcie lewym
przyciskiem myszy ustawia dany kolor jako pierwszoplanowy, klik-
nięcie prawym przyciskiem natomiast otwiera menu zawierające
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zbiór funkcji umożliwiających modyfikowanie bieżącej palety. Mo-
dyfikacje palety przeprowadzane są na bieżąco.

.��+��2�3!�����4�(5�(��!�����"�!����
Gimp obsługuje urządzenia wejściowe, takie jak tablety graficzne,
o ile obsługuje je X serwer oraz GTK+ został skompilowany z opcją
rozszerzonej obsługi urządzeń wejściowych. W takim wypadku
omawiane okno dialogowe zawiera listę urządzeń wejściowych, które
można za jego pomocą konfigurować. W przypadku tabletów jedyną
rzeczą którą naprawdę należy skonfigurować jest to, czy obszar ta-
bletu ma być mapowany na cały ekran, czy też tylko na obszar ak-
tywnego okna.

2�3!���,���+���,����+�(5�(��!��
Omawiane okno dialogowe zawiera informacje o aktualnie wybranym
narzędziu, kolorze pierwszego planu, pędzlu, wzorze oraz gradiencie.
Wszystkie te informacje są już w zasadzie wyświetlane na przyborni-
ku; okno to staje się bardziej interesujące dopiero przy pracy z wielo-
ma urządzeniami wejściowymi. Jeżeli urządzenia te zostały skonfigu-
rowane, w oknie dialogowym Device Status (Stan urządzenia) wyświetlane
są informacje o ustawieniach każdego z urządzeń (patrz „Input Devices
(Urządzenia wejściowe)”). Część ustawień może być kopiowana po-
między urządzeniami — wystarczy przeciągnąć z jednego urządzenia
do drugiego atrybut, który ma zostać skopiowany. Jeżeli uaktywniono
opcję Save Device Settings on Exit (Zachowaj ustawienia urządzenia
przy wyjściu), ustawienia urządzeń zostaną przywrócone przy ponow-
nym uruchamianiu Gimpa.

2��+�����.���1��.��� ���� +����6��
Indeks dokumentów zawiera spis wszystkich obrazów kiedykolwiek
otwieranych za pomocą Gimpa. Omawiane okno dialogowe rozszerza
możliwości listy historii obrazów w menu File (Plik) przybornika.
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Gdy otwarte jest okno dialogowe konsoli błędów, pojawiają się w nim
informacje o wszystkich błędach, które normalnie byłyby wyświetlane
w odrębnych oknach dialogowych.
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To okno dialogowe umożliwia wybranie dostępnych filtrów z listy po
lewej stronie i dodanie ich do listy filtrów aktywnych po prawej. Filtry
te wpływają na sposób wyświetlania rysunków i mogą być wykorzy-
stywane przy kalibrowaniu monitora. Jedyną ich złą stroną jest to, że
w chwili pisania tych słów dostępnych jest bardzo niewiele filtrów.

4����-!����	��-!����!��
Okno dialogowe Undo History, które można otworzyć tylko z poziomu
menu Image (Obrazek) (<Image>Dialogs→Undo History (<Obrazek>
Okna dialogowe→Historia)), zawiera listę ostatnio dokonanych zmian
rysunku, które nadal można cofnąć. Kliknięcie podglądu natychmiast
przywróci rysunek do stanu poprzedzającego wybraną czynność. Liczbę
czynności, które można cofać, ustala się za pomocą okna dialogowego
Preferences (Preferencje) (patrz „Preferences (Preferencje)”).

������%���������
W menu Filters znajduje się większość dodatków rozszerzających
możliwości Gimpa.

$����������������6�(�������!5��(	���"8������%/�
Ponownie uruchamia ostatnio używany moduł rozszerzający z takimi
samymi ustawieniami co poprzednio.
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Otwiera okno dialogowe ostatnio używanego modułu rozszerzającego.
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Pozwala zaawansowanym programistom Perla zastosować dostępne
w Gimpie funkcje Perla bezpośrednio na wszystkich warstwach rysunku.
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Pozwala na wybranie modułu rozszerzającego z długiej listy — wybrany
filtr, zgodnie z ustalonymi lub możliwymi do ustalenia parametrami, jest
następnie wykonywany w odniesieniu do wszystkich warstw rysunku.
Opcja ta jest szczególnie przydatna w trakcie pracy nad animacjami.

*
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Zapewnia dostęp do różnych funkcji rozmywania:

Blur (Rozmyj)
Klasyczna funkcja rozmywająca obraz przy wykorzystaniu ma-
trycy 3×3 piksele. Operacja ta może być przeprowadzana wiele
razy w jednym kroku.

Gausian Blur (Rozmyj gaussowsko) (IIR)
Funkcja rozmycia dobrze dostosowana do dużych promieni i gład-
kich przejść kolorów (skanów i fotografii).

Gausian Blur (Rozmyj gaussowsko) (RLE)
Dobrze sprawdza się w przypadku rysunków zawierających duże
obszary o tym samym kolorze (obrazów generowanych kompute-
rowo)



33-94.doc 41/62

Image Window (Okno obrazu) 41

Motion Blue (Poruszenie)
Symuluje rozmycie wynikające z poruszenia, nakładając na sie-
bie wiele kopii obrazu.

Pixelize (Pikselizacja)
Pikselizuje rysunek sprawiając, że wygląda on jakby był ogląda-
ny w dużym powiększeniu.

Selective Gausian Blur (Selektywnie rozmyj gaussowsko) (RLE)
Jeszcze jeden filtr rozmycia gaussowskiego. W przeciwieństwie do
innych filtr ten nie rozmywa sąsiadujących ze sobą pikseli, jeśli bar-
dzo się od siebie różnią — dzięki temu zachowany zostaje kontrast.

Tileable Blur (Rozmycie kafelkowe)
Skrypt ułatwiający tworzenie tapet — przed przeprowadzeniem
rozmycia dzieli on rysunek na kafelki a po rozmyciu go usuwa
efekt kafelkowania.

��
�������
��	�
Zawiera funkcje obsługi koloru niedostępne z poziomu menu <Image>
Image→Colors (<Obrazek>Obrazek→Kolory):

Map (Mapowanie)
Filtry w tym menu pozwalają na mapowanie kolorów lub całych
zakresów kolorów na inne kolory:

Adjust FG-BG (Zmień FG-BG)
Zmienia wszystkie piksele w kolorze pierwszego planu na
czarne i wszystkie piksele w kolorze tła na białe.

Alien Map 1 and 2 (Obca mapa 1 i 2)
Zmienia kolory rysunków sprawiając, że stają się one pełne
kolorów i nierealistyczne.

Color Exchange (Wymiana kolorów)
Zamienia jeden kolor na inny.

Color Range Mapping (Mapowanie zakresu kolorów)
Mapuje cały zakres kolorów na inny.
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Gradient Map (Mapuj gradient)
Koloruje rysunek za pomocą aktywnego gradientu wyświetlane-
go w przyborniku. Docelowy kolor pikseli zależy od ich jasności.

Sample Colorize (Koloruj próbką)
Ciekawy moduł rozszerzający służący do kolorowania czar-
no-białych fotografii. Kolory odniesienia są pobierane z dru-
giego (kolorowego) obrazu.

Border Average (Średnia krawędzi)
Ustawia kolor tła zgodny ze średnią kolorów krawędzi rysunku.

Colort to Alpha (Kolor do kanału Alfa)
Sprawia, że wszystkie piksele o zadanej barwie stają się przeźro-
czyste w taki sposób, że jeśli pod rysunkiem znajdzie się war-
stwa tego samego koloru, oryginalny rysunek zostanie odtworzo-
ny. Pozwala to na łatwe zmienianie kolorów tła w rysunkach
wtapiających się w monotonne tło.

Colorify (Koloryzuj)
Tworzy koloryzowany monochromatyczny obraz, podobny do
obrazu w odcieniach szarości.

Fire (Ogień) (W)
Tworzy dookoła obrazu płonącą obwódkę.

Hot (Ciepło)
Wyszukuje i modyfikuje kolory, które sprawiłyby problemy pod-
czas konwersji do telewizyjnego formatu PAL lub NTSC.

Max RGB (Maksimum RGB)
Wyszukuje maksymalną wartość każdego kanału koloru każdego
piksela a następnie zeruje wartość wszystkich kanałów pozostałych.

Semi-Flatten (Pół-spłaszczanie)
Zastępuje wszystkie półprzeźroczyste piksele kolorem tła. Funk-
cja ta jest użyteczna w przypadku rysunków w formacie GIF,
ponieważ format ten nie obsługuje półprzeźroczystości. Przed
wywołaniem filtra należy ustawić w Gimpie kolor tła na taki
sam, jak kolor tła docelowej strony WWW.
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Smooth Palette (Wygładź paletę)
Tworzy nowy rysunek zawierający kolory oryginału w formacie
przystosowanym do modułu rozszerzającego Flame (<Image>
Filters→Render→Nature (<Obrazek>Filtry→Rendering→Natura)).

Value Invert (Odwróć wartość)
Odwraca rysunek w przestrzeni kolorów HSV zachowując przy
tym barwę i nasycenie.

:�!����,(+��
Poniższe filtry generują efekty szumu:

Ditherize (Rozpraszaj) (W)
Redukuje liczbę kolorów rysunku tak, jakby została wybrana
opcja <Image>Image→Mode→Indexed (<Obrazek>Obrazek
→Tryb→Indeksowany), ale nie konwertuje przy tym rysunku do
indeksowanego formatu kolorów.

Hurl (Zarzuć)
Dodaje do rysunku piksele o losowych kolorach.

Noisify (Zaszum)
Dodaje do rysunku losowy szum.

Pick (Mieszaj)
Zastępuje losowe piksele kopią pikseli w ich sąsiedztwie.

Scatter HSV (Rozrzuć HSV)
Rozrzuca kolory w przestrzeni kolorów HSV dodając szum do
rysunku.

Slur (Roztop)
Działa podobnie jak polecenie Pick (Mieszaj), zastępując piksele
pikselami z ich sąsiedztwa. Istnieje jednak większe prawdopodo-
bieństwo wybrania piksela położonego powyżej piksela zastępo-
wanego, co sprawia że rysunek wygląda jakby się topił.
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Spread (Rozlej)
Przesuwa losowe piksele w określonym stopniu. Tworzy dziwny
efekt rozmycia.

Xach Vision (Kamera techniczna) (W)
Nakłada na rysunek filtr koloru i czarne linie, symulując sposób
w jaki roboty widzą otoczenie (a przynajmniej sposób, w jaki ro-
bią to według osób, które oglądają zbyt często telewizje).

7�;��2��������	 �	���!�� ���)�(!�
Znajdujące się tu filtry wykrywają i wyróżniają krawędzie, analizując
występowanie na rysunku obszarów o dużej intensywności:

Edge (Krawędzie)
Wyświetla odnalezione krawędzie w ich oryginalnych kolorach
na czarnym tle.

Laplace
Koloruje krawędzie zależnie od zmian intensywności na czar-
nym tle.

Sobel
Działa podobnie do funkcji Laplace z tym, że algorytm ten bie-
rze pod uwagę także kierunek krawędzi i generuje gładsze i nieco
szersze linie.

7����������
���(�
Funkcje te, szczególnie użyteczne przy edycji skanowanych obrazów,
pozwalają polepszyć jakość rysunku:

2×2 Contrast Enhance (Polepszenie kontrastu 2×2) (W)
Polepsza kontrast za pomocą prostego algorytmu wykorzystują-
cego matrycę 2×2.
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Deinterlace (Usuń przeplot)
Dodaje brakujące linie do obrazu ze źródła video interpolując li-
nie istniejące.

Despeckle (Usuń pyłki)
Usuwa drobinki kurzu i małe zadrapania z zeskanowanych obrazów.

Destripe (Usuń paski)
Usuwa poziome paski tworzone przez niektóre tanie skanery.

NL Filter
Port programu pnmnlfilt z pakietu pnm. Ten bardzo wszechstron-
ny moduł rozszerzający zapewnia dostęp do zbioru nielinearnych
algorytmów wykorzystywanych przy wygładzaniu obrazu, usu-
waniu błędów pikseli i akcentowaniu krawędzi.

Sharpen (Wyostrz)
Zwiększa ostrość obrazu. Lepsze rezultaty zazwyczaj osiąga się
za pomocą filtru Unsharp Mask.

Unsharp Mask (Nieostra maska)
Nakłada na obraz dwie maski tworzone na drodze rozmycia ory-
ginalnego obrazu. Choć może wydawać się to bardzo dziwne,
wyostrza to obraz i, w przeciwieństwie do polecenia Sharpen
(Wyostrz), pozostawia bardzo niewiele artefaktów.

Warp Sharp (Wyostrzenie poprzez rozciąganie) (W)
Jeszcze jeden sposób wyostrzania obrazu. Wykorzystywany tu
algorytm często daje jeszcze lepsze rezultaty niż Unsharp Mask
(Nieostra maska).

0����!���';6
���
Poniższy ogólny filtr można wykorzystywać w celu osiągnięcia wielu
różnych efektów:
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Convolution Matrix (Matryca zniekształcania)
Umożliwia dokonywanie zmian rysunku za pomocą dowolnie
definiowalnej matrycy 5×5. Można w ten sposób uzyskiwać
efekty rozmywania i przesuwania.

0
����7��������,( ���
Funkcje te tworzą efekty światła przeświecającego przez szklane po-
wierzchnie:

Apply Lens (Soczewka)
Pokazuje rysunek tak, jakby był oglądany za pomocą okrągłej
soczewki.

Glass Tile (Szklane kafelki)
Tworzy wrażenie oglądania rysunku poprzez wypukłe szklane
kafelki.

�!;���7��������7�� �	�"�!��
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Poniższe filtry symulują efekty świetlne:

Flare FX (Flara FX)
Symuluje odbicie światła w obiektywie, tak jakby słońce odbi-
jało się w soczewce aparatu.

GFlare (Flara G)
Tworzy odbicie światła podobne do Flare FX (Flara FX), ale
udostępnia więcej opcji konfiguracyjnych.

Lighting Effect (Efekt błyskawicy)
Kompleksowy filtr symulujący różne efekty błyskawic i środo-
wiskowe. Rysunki w skali szarości mogą być wykorzystywane
jako mapy wypukłości, rysunki w trybie RGB jako mapy środo-
wiskowe itp.
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Sparkle (Połysk)
Rozjaśnia jasne obszary i nadaje im połysk. W fotografii efekt
ten uzyskuje się za pomocą specjalnego filtra.

SuperNova (Supernowa)
Tworzy efekt przypominający eksplozję światła. Można modyfi-
kować wiele parametrów takich jak kolor czy pozycja.

2!��������9�!� �(������!��

Poniższe funkcje przemieszczają piksele rysunku:

Blinds (Żaluzje)
Tworzy efekt zamkniętych lub otwartych żaluzji przesłaniają-
cych obraz.

CurveBend (Zagięcie)
Zagina aktualnie zaznaczony obszar lub warstwę zgodnie ze zde-
finiowaną krzywą.

Embross (Płaskorzeźba)
Tworzy z rysunku płaskorzeźbę w odcieniach szarości. Można
również zachować kolory — w takim wypadku efekt będzie przy-
pominał działanie funkcji Bump Map (<Image>Filters→Map
(<Obrazek>Filtry→Mapowanie)).

Engrave (Grawerowanie)
Tworzy wzór pasków. Grubość pasków odpowiada intensywno-
ści danego obszaru oryginału.

Inwarp (Rozciąganie)
Pozwala na zmodyfikowanie obrazu w oknie podglądu za pomo-
cą myszy. Modyfikacje te zostają następnie przeniesione na ob-
raz. Można również stworzyć animację efektu rozciągania.

Mirror Split (Odbicie lustrzane) (W)
Dzieli obraz przez środek i zastępuje jedną połowę lustrzanym
odbiciem drugiej.



48/62 33-94.doc

48 Gimp. Leksykon kieszonkowy

Newsprint (Druk gazetowy)
Symuluje efekt rastra gazetowego.

Pagecurl (Stronicowanie)
Tworzy efekt przewracanej strony.

PolarCoords (Współrzędne biegunowe)
Przekształca współrzędne prostokątne rysunku (kartezjańskie) na
współrzędne biegunowe i vice versa.

Ripple (Marszczenie)
Przesuwa piksele zgodnie z kształtem wybranej fali, tworząc
efekt flagi powiewającej na wietrze.

Scratches (Zadrapania) (W)
Tworzy efekt matowego metalu umieszczając na rysunku wiele
równoległych zadrapań. Dobrze wygląda na metalicznych gra-
dientach i gradientach w odcieniach szarości.

Shift (Przemieść)
W losowy sposób przemieszcza piksele w pionie i poziomie.

Value Propagate (Propagowanie wartości)
Przesuwa i akcentuje piksele w zależności od ich intensywności.

Video (Video)
Tworzy wrażenie oglądania źle nastrojonego telewizora.

Waves (Fale)
Tworzy na obrazie rozbiegające się fale, przypominające po-
wierzchnie stawu po wrzuceniu kamienia.

Whirl and Pinch (Wirowanie i ściśnięcie)
Skręca i ściska obraz.

Wind (Wiatr)
Tworzy komiksowy efekt wiatru poprzez poziome rozmywanie
krawędzi obrazu.

Windify (Podmuch) (W)
Rozdmuchuje piksele.



33-94.doc 49/62

Image Window (Okno obrazu) 49

���!��!������	��	�(���

Poniższe efekty udają klasyczne style rysowania:

Apply Canvas (Nałóż płótno)
Sprawia, że rysunek wygląda jakby został namalowany na nie-
równym płótnie.

Cubism (Kubizm)
Zastępuje rysunek małymi, półprzeźroczystymi kwadratami roz-
mieszczonymi i pokolorowanymi w ten sposób, by w przybliże-
niu oddawały wygląd oryginału.

GIMPressionist (GIMPresionista)
Ponownie pokrywa obraz aktualnie wybranym pędzlem. Można
skonfigurować tu po prostu wszystko — rozmiar i formę pędzla,
styl malowania, powierzchnię.

Oilify (Olej)
Udaje malowanie olejem.

������������!��
Poniższe filtry można wykorzystać do mapowania rysunku na różne
powierzchnie:

Bump Map (Mapa wypukłości)
Tworzy trójwymiarowy efekt wykorzystując jasność pikseli ry-
sunku jako informację o wysokości oraz ustalając padanie świa-
tła z wybranego kierunku.

Displace (Wyprzyj)
Przenosi piksele rysunku o odległość zależną od jasności pikseli
Displacement Maps w danym miejscu.

Fractal Trace (Śledzenie fraktalne)
Zmienia rysunek za pomocą fraktala Mandelbrota.
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Illusion (Iluzja)
Umieszcza kopie oryginału w okręgu dookoła centrum obrazu,
sprawiając wrażenie, że obraz jest oglądany za pomocą kalejdo-
skopu.

Image Tile (Kafelkowanie rysunku) (W)
Tworzy mozaikę z kilku obrazów przypominających obraz z któ-
rego okna został wywołany skrypt. Obrazy mozaiki są pobierane
z podanych katalogów.

Make Seamless (Ujednolić)
Umożliwia tworzenie z rysunku zazębiającej się ze sobą tapety.

Map Object (Mapuj obiekt)
Umieszcza rysunek na planie sfery lub płaszczyzny. Można
zmieniać na wiele sposobów powierzchnie, orientacje i oświetle-
nie obiektu.

Paper Tile (Wycinanka)
Tnie obraz na wiele fragmentów, które następnie zostają nieco od
siebie odsunięte.

Pixelmap (Mapa pikseli) (W)
Stosuje wyrażenie Perla bezpośrednio na wartości pikseli obrazu.

Small Tiles (Małe fragmenty)
Zastępuje oryginalny rysunek zbiorem małych fragmentów ory-
ginału (przy czym wymiary rysunku pozostają niezmienione).
Pojedyncze fragmenty mogą zostać obrócone.

Tile (Fragmentuj)
Generuje większy rysunek tworząc zbiór fragmentów oryginału.

Van Gogh (LIC)
W zależności od źródła obrazu (szumu lub jakiegoś aktualnego
rysunku) filtr ten można wykorzystać do tworzenia ciekawych
tekstur lub do rozmywania.



33-94.doc 51/62

Image Window (Okno obrazu) 51

Warp (Rozciągnij)
Filtr ten wymaga innego rysunku jako matrycy zniekształcania.
Po wykonaniu funkcji rysunek będzie mocno zniekształcony.

Xach Blocks (Klocki) (W)
Mapuje rysunek na powierzchnię przypominającą trochę klocek
Lego.

Xach Shadow (Cień) (W)
Ponownie tworzy obraz za pomocą małych elementów, układa-
nych w ciekawy, trójwymiarowy sposób.

$�������$�����!�;�
Poniższe filtry renderują nowy obraz. Warstwa aktywna w chwili wy-
wołania jednego z tych filtrów zazwyczaj zostaje zastąpiona nową za-
wartością i jest wykorzystywane tylko w celu ustalenia typu i rozmia-
rów tworzonego obrazu. Do filtrów renderowania zaliczają się:

Clouds (Chmury)
Niezbyt użyteczne przy próbie zasymulowania chmur na niebie.
Efekty te są jednak zamiast tego często wykorzystywane jako
źródło efektów mapowania wypukłości:

Plasma (Plazma)
Renderuje kolorowe chmury plazmy.

Solid Noise (Stały szum)
Renderuje obraz w skali szarości przy pomocy funkcji za-
szumiania.

Nature (Natura)
Poniższe opcje pozwalają tworzyć naturalnie wyglądające obrazy:

Flame (Płomień)
Skomplikowany moduł rozszerzający generujący fraktale,
które czasami wyglądają jak płomienie. Aby filtr ten mógł
korzystać z palet stworzono moduł rozszerzający Smooth
Palette (<Image>Filters→Colors (<Obrazek>Filtry→Kolory)).
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IfsCompose
Pozwala na obliczanie specjalnego rodzaju fraktala (Iterated
Function System), który czasem przypomina wyglądem drzewa
lub krzewy. Moduł pozwala również na obliczanie klasycz-
nych fraktali, takich jak na przykład trójkąt Sierpińskiego.
Równanie wykorzystywane do tworzenia określonego obrazu
jest zachowywane gdy rysunek zapisuje się w formacie XCF.
Umożliwia to dalsze zmienianie rysunku lub też generowanie
za jego pomocą fraktala o innych rozmiarach w przyszłości.

Pattern (Wzór)
Poniższe moduły rozszerzające wykorzystuje się przed wszyst-
kim do generowania wzorów tła:

CML Explorer (Eksplorator CML)
Wykonuje kompleksowy zbiór funkcji matematycznych two-
rząc psychodeliryczne obrazy czasem przypominające wy-
glądem kurtyny.

Checkerboard (Szachownica)
Tworzy wzór szachownicy.

Diffraction Patterns (Wzory dyfrakcji)
Tworzy wzory dyfrakcji wyglądające jak pierścienie interfe-
rencji.

Fractal Explorer (Eksplorator fraktali)
Pozwala odbyć fascynującą podróż w świecie fraktali.

Grid (Siatka)
Nakłada na obraz czarną siatkę, którą można wykorzystać
przy rozmieszczaniu elementów rysunku.

Jigsaw (Układanka)
Tworzy układankę przedstawiającą oryginalny rysunek.

Maze (Labirynt)
Tworzy labirynt (bez gwarancji, że istnieje z niego jakieś
wyjście).
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Mosaic (Mozaika)
Tworzy mozaikę przedstawiającą oryginalny rysunek.

Qbist (Abstrakcja)
Tworzy rysunek wykorzystując algorytmy genetyczne, dzięki
czemu przypomina on sztukę abstrakcyjną.

Add Dust (Dodaj kurz) (W)
Dodaje do rysunku drobiny kurzu, takie jak można zobaczyć na
starych przeźroczach.

Add Glow (Dodaj żarzenie) (W)
Sprawia, że obiekty na przeźroczystej warstwie zaczynają
świecić się.

Brushed Metal (Matowy metal) (W)
Tworzy powierzchnię wyglądającą jak matowy metal.

Burst (Pęknięcie) (W)
Tworzy linie zbiegające się w środku wybranego obszaru.

Dynamic Text (Tekst dynamiczny)
W przeciwieństwie do standardowego narzędzia umieszczania tek-
stu moduł rozszerzający Dynamic Text (Tekst dynamiczny) po-
zwala umieszczać na rysunku wiele wierszy tekstu równocześnie.
Tekst może być wyrównany do lewej, do prawej oraz wyśrodko-
wany. Moduł rozszerzający potrafi odczytywać tekst z pliku tek-
stowego, obracać go oraz wykonywać wiele innych czynności.
Najbardziej jednak ciekawą funkcją tego modułu jest możliwość
edycji tekstu już po tym jak został umieszczony. W tym celu nale-
ży po prostu wywołać go w chwili gdy aktywna jest odpowiednia
warstwa tekstowa. Ograniczeniem jest tu wymóg braku jakiejkol-
wiek modyfikacji warstwy tekstowej od chwili umieszczenia
w niej tekstu — w przeciwnym wypadku wszystkie zmiany zosta-
ną utracone.

Fit tekst (Dopasuj tekst) (W)
Wypełnia tekstem wybraną warstwę — lub też, jeśli niczego nie
zaznaczono, cały obraz — w najlepszy możliwy sposób. Wystar-
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czy tylko wybrać czcionkę i podać tekst, który ma zostać umiesz-
czony na ekranie.

Gfig
Niemalże niezależny program do rysowania grafiki wektorowej.
Gfig zapewnia dostęp do olbrzymiej liczby kształtów geome-
trycznych. Można również zapisywać i otwierać rysunki. Naci-
śnięcie przycisku Paint nanosi bieżący rysunek modułu Gfig na
obraz lub warstwę za pomocą aktywnego pędzla.

Highlist Edges (Wyróżnij krawędzie) (W)
Tworzy prosty, trójwymiarowy efekt w przypadku warstw z usta-
wioną przeźroczystością kanału alfa, przyciemniając ich krawędzie
z jednej strony i rozjaśniając z drugiej.

Random Blends (Losowe gradienty) (W)
Generuje losowe gradienty, które mogą tworzyć ciekawe obrazy.

Sinus
Wykorzystuje funkcję trygonometryczną do tworzenia gładkich,
falujących, dwukolorowych przejść.

Sphere Designer (Projektant sfer)
Tworzy sfery, umożliwiając przypisanie im różnych źródeł oświe-
tlenia, tekstur i map wypukłości.

Stampify (Znaczkowanie) (W)
Zamienia rysunek na znaczek pocztowy.

TEX String (Znaki TEX) (W)
Wykorzystuje TEX i kilka innych programów narzędziowych
w celu udostępnienia Gimpowi możliwości profesjonalnego
składu. Wymaga posiadania zainstalowanego w systemie pa-
kietu TEX.

Terral Text (Tekst schodkowy) (W)
Tworzy tekst z ciekawym efektem trójwymiarowości.
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Oto kilka użytecznych narzędzi projektowanych z myślą o tworzeniu
grafiki dla potrzeb stron WWW:

Image Map (Mapy obrazu)
Pomaga tworzyć mapy obrazu (rysunki z przypisanymi różnymi
odnośnikami do różnych obszarów).

Perl-o-tine (W)
Tak samo jak funkcja Guillotine (Gilotyna) (<Image>Image→
Transforms→Guillotine (<Obrazek>Obrazek→Transformacje→
Gilotyna)) tnie rysunek na kawałki zgodnie z istniejącymi liniami
przewodnimi. Omawiany moduł rozszerzający zapisuje jednak
również fragmenty rysunku w formacie GIF i tworzy kod HTML
pozwalający zrekonstruować oryginalny rysunek z fragmentów
za pomocą tabeli HTML.

Prepare to GIF (Przygotuj do formatu GIF) (W)
Pomaga tworzyć GIF-y łagodnie stapiające się z tłem, podobnie jak
funkcja Semi-Flatten (Pół-spłaszczanie) (<Image>Filters→Colors
→Semi-Flatten (<Obrazek>Filtry→Kolory→Pół-spłaszczanie))

Webify (Usieciawiaj) (W)
Automatyzuje czynności niezbędne to stworzenia rysunku w for-
macie GIF do wykorzystania na stronie internetowej.

��;+�����������(��!��(�� 6���!����	�������
Menu <Toolbox>Xtns→Script-Fu (<Przybornik>Xtns→Script-Fu) za-
wiera wiele skryptów tworzących loga. Można wykorzystywać je nie
tylko do wzbogacania tekstu o różne efekty, ale również przy edycji
innych elementów obrazu. Aktywna warstwa musi posiadać kanał Alfa
(tj. przeźroczystość).

�����

Istnieje możliwość, że w wersji 1.2 Gimpa Logurator zostanie usu-
nięty i najprawdopodobniej zastąpiony funkcjami Alpha to Logo
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(Kanał Alfa na logo) znajdującymi się w menu Script-Fu. Decyzja
o pozostawieniu bądź usunięciu opcji Logurator z Gimpa 1.2 nie
została jeszcze podjęta w chwili pisania tych słów.

��!���!������!������
Poniższe moduły rozszerzające zaprojektowano z myślą o tworzeniu,
edycji i odtwarzaniu animowanych GIF-ów przy wykorzystaniu warstw
jako klatek animacji:

Animate Cells (Animuj komórki) (W)
Scala każdą warstwę z warstwą tła. Może być to pomocne przy
tworzeniu animacji przedstawiających obiekt poruszający się na
stałym tle.

Animation Optimize (Optymalizuj animację)
Sprawia, że piksele które nie zmieniają swojej pozycji pomiędzy
sąsiednimi klatkami animacji stają się przeźroczyste. Może to
znacznie zmniejszyć rozmiar pliku.

Animation Playback (Odtwórz animację)
Odtwarza animację, umożliwiając sprawdzenie czy nadaje się już
ona do wstawienia na stronę WWW. Animację lub rysunek moż-
na usunąć z okna przeciągając ją za pomocą myszki i umiesz-
czając w dowolnym miejscu ekranu.

Animation UnOptimize (Cofnij optymalizację animacji)
Cofa optymalizację animacji zastępując przeźroczyste piksele
ramki kolorem poprzedniej ramki w tym samym punkcie.

BlowInOut (Zbliż i oddal) (W)
Tworzy animację szybko przybliżającą a następnie oddalającą
bieżącą warstwę rysunku.

���
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Poniższe funkcje łączą ze sobą różne obrazy:
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Depth Merge (Głębokie scalanie)
Łączy ze sobą dwa obrazy wykorzystując przy tym dwa inne obrazy
używane w roli map wysokości. Dla każdej pozycji, na scalonym ob-
razie pojawia się piksel rysunku, którego mapa wysokości jest niższa
w danym miejscu. Wszystkie obrazy muszą mieć te same wymiary.

Film
Tworzy rysunek udający taśmę filmową, na którym każda war-
stwa oryginalnego obrazu ma własną klatkę. Do filmu można
dodać wszystkie otwarte obrazy.

��	���9�
�� !�
Poniższy moduł rozszerzający zawiera zbiór efektów, które wprawdzie
są kompletnie nieprzydatne, ale za to przyciągają wzrok jak nic innego:

The Egg (Jajko)
„Wielkanocne jajko” Gimpa. Rada: efekt można zmieniać za po-
mocą przycisków myszy.

*����%��$�
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Znajdujące się w tej części skrypty Perla znacznie upraszczają pracę
z liniami przewodnimi. Sposób korzystania z linii przewodnich opisa-
no szerzej w dziale „Move Tool (Przesunięcie) (M)”.

Center Guide (Środkowe linie przewodnie) (W)
Tworzy dwie linie przewodnie przecinające się w środku obrazu.

Guide Grid (Siatka linii przewodnich) (W)
Tworzy siatkę z równomiernie rozmieszczonych linii przewodnich.

Remove Guides (Usuń linie przewodnie) (W)
Usuwa wszystkie znajdujące się na rysunku linie przewodnie.

To Selection (Na zaznaczenie) (W)
Zaznacza obszar rysunku pomiędzy istniejącymi liniami przewod-
nimi. Za pomocą funkcji <Image>Edit→Stroke (<Obrazek>Edycja
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→Pociągnięcie pędzla) można na przykład w ten sposób obryso-
wać linie przewodnie aktualnie wybranym pędzlem.

 ���������"�
Moduł rozszerzający zapewniający obsługę animacji w Gimpie (GAP
— Gimp Animation Plug-In) zawiera zbiór funkcji przydatnych podczas
tworzenia i edycji animacji. Jego twórcy wyszli z założenia, że w prze-
ciwieństwie do animacji w formacie GIF, w których każda ramka jest
warstwą obrazu, w zwyczajnych animacjach każda ramka będzie zapi-
sywana w osobnym, numerowanym pliku na dysku i będzie mogła mieć
dowolną liczbę warstw. Najważniejsze jednak jest to, że dana funkcja
może być zastosowana zgodnie ze zmiennymi lub stałymi ustawieniami
na wszystkich ramkach animacji. Poszczególne funkcje modułu GAP to:

Encode (Koduj)
GAP sam w sobie nie potrafi tworzyć filmów w formacie MPEG,
ale może wywołać odpowiednie programy (mpeg_encode lub
mpeg2encode) z prawidłowymi parametrami. Programy kodujące
muszą zostać zainstalowane oddzielnie.

Goto (Przejdź do)
Funkcja ta jest wykorzystywana do poruszania się w obrębie ani-
macji. Wybrana animacja jest wyświetlana w oknie bieżącej ani-
macji. Wygodnie jest przypisać do tych funkcji skróty klawiaturo-
we (patrz „Tworzenie i edycja skrótów klawiaturowych”).

Split Video to frames (Podziel film na ramki)
Generuje pliki ramek wybranego filmu. Film musi być w forma-
cie MPEG, należy również posiadać bibliotekę MPEG lub też
program odtwarzający xanim musi posiadać opcjonalną funkcję
eksportu.

Delete Frames (Usuń ramki)
Usuwa kilka ramek animacji poczynając od ramki bieżącej.
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Duplicate Frames (Powiel ramki)
Powiela ramki. Funkcję tę można wykorzystać przy tworzeniu
początkowego zbioru ramek animacji. Wystarczy zapisać rysu-
nek jako plik z nazwą kończącą się na _0001.xcf i kopiować tę
ramkę tak często, jak to jest konieczne.

Exchange Frames (Zamień ramki)
Zamienia aktualnie wybraną ramkę z inną ramką tej samej ani-
macji.

Frames Convert (Konwertuj ramki)
Konwertuje wszystkie ramki animacji do innego formatu pliku.
Czasem konieczne może się stać przekonwertowanie ramek do
formatu XJT w celu zaoszczędzenia miejsca na dysku. XJT za-
pewnia te same możliwości co format XCT z tą tylko różnicą, że
dane obrazu są w jego przypadku kompresowane algorytmem
JPEG. Wielokrotne odczytywanie i zachowywanie plików w for-
macie XJT może spowodować wystąpienie widocznych artefak-
tów, dlatego też nie jest to rozwiązanie zalecane.

Frames Crop (Przytnij ramki)
Przycina wszystkie ramki do tej samej wielkości.

Frames Flatten (Spłaszcz ramki)
Łączy ze sobą wszystkie warstwy każdej z ramek z osobna, po-
zostawiając w przypadku każdej ramki jedną warstwę bez kanału
Alfa.

Frames LayerDel (Usuń warstwę z ramek)
Usuwa daną warstwę ze wszystkich ramek.

Frames Modify (Zmień ramki)
Pozwala na wykonanie funkcji warstw, takich jak kopiowanie,
usuwanie lub łączenie, na wszystkich warstwach animacji pasują-
cych do podanego wzorca (mogą to być wszystkie widoczne war-
stwy lub też warstwy, których nazwy zawierają określone słowo).
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Frames Resize (Zmień rozmiar ramek)
Zmienia rozmiar wszystkich warstw animacji bez skalowania ich
zawartości. Funkcja ta jest odpowiednikiem opcji Resize.

Frames Scale (Skaluj Ramki)
Skaluje wszystkie ramki animacji wraz z ich zawartością. Odpo-
wiada funkcji skalowania obrazu.

Frames to Image (Ramki do obrazu)
Tworzy rysunek zawierający wszystkie klatki animacji w od-
dzielnych warstwach. Dzięki temu rysunek ten może zostać
przekształcony na animowanego GIF-a.

Framesequence Shift (Przenieś sekwencję ramek)
Przenosi sekwencję ramek w obrębie animacji.

Move Path (Ścieżka poruszania)
Przenosi warstwę w czasie trwania animacji. Ponieważ dana
warstwa może być w trakcie przenoszenia skalowana, z funkcji
tej można skorzystać przy tworzeniu wielu prostych animacji, ta-
kich jak odbijająca się piłka, poruszający się tekst lub przybliża-
jący się statek kosmiczny.

Split Image to frames (Podziel rysunek na ramki)
Tworzy ramki w formacie GAP z każdego obrazu zawierającego
ramki w postaci warstw.

VCR Navigation (Nawigacja VCR)
Komfortowy moduł komunikacyjny dla funkcji nawigacyjnych
— pozwala nawet wykonywać niektóre operacje na ramkach, ta-
kie jak kopiowanie ich i usuwanie.

������+��
Dostępne w tym menu skrypty modyfikują istniejący rysunek. Skrypty
tworzące nowe rysunki znajdują się w menu Xtns przybornika (<Tool-
box>Xtns (<Przybornik>Xtns). Tak jak pisano w punkcie „Undo Hi-
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story (Historia)” efektów działania większości funkcji Script-Fu nie
można odwrócić.

�
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Czary z udziałem rysunków:

Clothify (Nanieś na ubranie)
Sprawia, że rysunek wygląda jakby został namalowany na jakiejś
części ubrania.

Erase Every Other Row (Wymaż każdy inny rząd)
Robi właśnie to, co sugeruje nazwa: wymazuje wszystkie pozo-
stałe rzędy pikseli rysunku.

Predator
Zgodnie z niektórymi filmami akcji, właśnie tak widzą nasz
świat istoty pozaziemskie.

Unsharp Mask (Nieostra maska)
Zwiększa ostrość obrazu nakładając na niego dwie maski w po-
staci warstw.

Weave (Tkanina)
Sprawia że rysunek wygląda tak, jakby został namalowany na
materiale uplecionym z grubych pasków tkaniny.

�
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Menu <Toolbox>Xtns→Script-Fu (<Przybornik>Xtns→Script-Fu) za-
wiera skrypty umożliwiające tworzenie znaków firmowych. Skrypty
w opisywanym menu pozwalają wzbogacać o te efekty nie tylko tekst,
ale również kanał Alfa rysunku.

��!��������:��()�(!������(��!����!����!�
Poniższe skrypty tworzą animacje i są optymalizowane pod kątem two-
rzenia animowanych GIF-ów:
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Blend (Mieszanie)
Łączy dwie lub więcej warstw z warstwą tła.

Rippling (Powiewanie)
Sprawia, że rysunek faluje tak jak flaga.

Selection to AnimImage (Zaznaczony obszar do animacji)
Kopiuje aktualnie zaznaczony obszar i wykonuje na kopii wy-
braną funkcję ze stałymi lub zmieniającymi się parametrami two-
rząc w ten sposób animację.

Spinning Globe (Wirujący glob)
Nakłada rysunek na obraz wirującego globu.

Waves (Fale)
Wykorzystuje moduł rozszerzający Waves (<Image>Filters→
Distorts (<Obrazek>Filtry→Zniekształcenia)) do tworzenia fal,
takich jakby ktoś wrzucił kamień do lustra wody.

2������2� �������
Poniższe skrypty dekorują rysunki kilkoma ładnymi efektami:

Add Bevel (Dodaj ramkę)
Rysuje dookoła rysunku lub zaznaczonego obszaru trójwymia-
rową ramkę.

Add Border (Dodaj obwódkę)
Dodaje do rysunku kolorową, trójwymiarową obwódkę.

Coffee Stain (Plama z kawy)
Dodaje do rysunku efekt plamy z kawy.

Fuzzy Border (Łagodna krawędź)
Sprawia, że krawędzie rysunku łagodnie przechodzą do koloru tła.

Old Photo (Stara fotografia)
Sprawia że rysunek wygląda jak stara, wyblakła fotografia.
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Round Corners (Zaokrąglaj narożniki)
Zaokrągla narożniki rysunku oraz, opcjonalnie, kładzie za nimi cień.

Slide (Slajd)
Dodaje do rysunku obramowanie sprawiające, że obraz wygląda
na slajd filmowy.

$�������$�����!�;�
Poniższe skrypty renderują na obrazie następujące efekty wizualne:

Circuit (Obwody)
Wygląda jak schemat obwodów drukowanych.

Lava (Lawa)
Tworzy efekt magmy przeświecającej przez szczeliny ciemnej lawy.

Line Nova (Supernowa linii)
Rysuje linie biegnące od centrum rysunku do krawędzi aktualne-
go koloru tła.

Make Grid System (Stwórz system siatek)
Tworzy system siatek dzielący rysunek.
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Poniższe skrypty modyfikują krawędzie zaznaczonego obszaru:

Distress Selection (Rozpaczliwe zaznaczenie)
Narusza krawędzie zaznaczenia tak, że wygląda ono jakby dany
obszar zaznaczano drżącą ręką. Niekoniecznie zachowywany jest
przy tym rozmiar zaznaczenia.

Fade Outline (Przyciemnij zaznaczenie)
Delikatnie przyciemnia rysunek w zaznaczonym obszarze.

Round (Zaokrąglij)
Zaokrągla narożniki zaznaczenia.
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To Brush (Do pędzla)
Tworzy pędzel z aktualnie zaznaczonego obszaru i zapisuje go
w katalogu pędzli.

To Image (Do rysunku)
Kopiuje zawartość zaznaczonego obszaru do nowego rysunku.
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Poniższe funkcje wzbogacają rysunek o różne efekty cienia:

Drop Shadow (Rzuć cień)
Nadaje rysunkowi lub zaznaczonemu obszarowi cień, sprawiając,
że wygląda on jakby unosił się nad tłem.

Perspective (Perspektywa)
Generuje cień perspektywiczny.

Xach Effect (Efekt Xach)
Dodaje do rysunku lub zaznaczonego obszaru trójwymiarowy
efekt, wyglądający tak, jakby w danym miejscu wydarto dziurę
w materiale.
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Poniższe dwa skrypty opierają generowane niezwykłe efekty na rysun-
kach w odcieniach szarości:

Carve-It (Odciśnij)
Odciska rysunek w skali szarości na dowolnym otwartym rysunku.

Chrome-It (Chromuj)
Konwertuje rysunek w odcieniach szarości na lśniącą, chromo-
waną powierzchnię.


